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Data Acquisition and Processing Report

NOAA Ship Thomas Jefferson
Chief of Party: CDR Lawrence T. Krepp
Year: 2011
Version: 1.0
Publish Date: 2011-09-01

A.1 Survey Vessels

A.1.1 NOAA Ship THOMAS JEFFERSON

Name NOAA Ship THOMAS JEFFERSON
Hull Number S222
Descrintion Hydrographic Survey vessel designed and built by Halter Marine, Inc., Moss Point,
P MS. Home Port: Norfolk, VA
NOAA Ship THOMAS JEFFERSON's primary mission is to acquire hydrographic
survey data to update NOAA Nautical Chartsin support of maritime commerce and
e safety of navigation. Other missions include Integrated Ocean and Coastal Mapping
Utilization LD . : : .
missions in support of missions such as benthic habitat mapping, wreck surveys, and
other research oriented survey operations. The ship is also occasionally employed in
buoy deployment and recovery operations.
LOA 208 feet
Dimensions Beam 45 feet
Max Draft 16.3 feet
Date 2003-05-07
Performed By National Geodetic Survey (NGS)
Most Recent Full NGS performed afull, static survey
Satic Survey during which they surveyed the distance

Discussion from IMU to the Notch Reference Point
and updated the transducer to Notch
Reference Point distance.
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Date 2005-03-10
Performed By National Geodetic Survey (NGYS)
Most Recent Partial A partial re-survey of THOMAS
Satic Survey JEFFERSON vessdl offsets was
Discussion conducted by NGS personnel, and no
physical changes in offsets have occurred
since then.
Most Recent Fulll e
Offset Verification Full offset verification was not performed.
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Date 2010-10-01
Method Used Confidence check

Most Recent Partial
Offset Verification

Discussion

The THOMAS JEFFERSON verified
NGS measurements and found one z-
value offset of 20 cm on S222 Reson
7125, which appears to have been

the z-value for the port transducer
instead of the starboard transducer. As
aresult of ERS processing on survey
H12180 during the fall of 2010, it was
determined that the 2005 partial survey
did not adequately take into account

the alignment of the POS antennas with
respect to vessel reference frame. This
was evident in the Calibrated Installation
Parameters report generated by the GNSS
processor in POSMMS5.3. X, Y, and

Z offsets were settling in on values that
differed from the installation parameter
values entered in MV/POSView based
on the 2005 NGS survey. The differences
in offsets are insignificant for surveys
reduced to MLLW viatraditional tides
application because the vertical offset

of the antenna does not affect survey
depths. Only horizontal positioning

Is affected by the inaccuracies of the
antenna offsets. Since the horizontal
offsets determined for the antennas is
significantly smaller than the horizontal
positioning requirement for IHO Order 1
surveys, no reprocessing is necessary for
surveys submitted viatraditional discrete
zoning. For ERS surveys, the antenna
heights do affect the final survey depths
because the soundings are referenced to
the ellipsoid based on the 3-D positioning
determined by the GNSS processing of
POSPac data, which are then reduced to
MLLW viaa SEP model, whichisagrid
of the difference between the ellipsoid
and MLLW for agiven area. Through
an iterative process by which calibrated
installation parameters were applied and
the SBET re-processed using the GNSS
processor, precise values for the antenna
positions with respect to the IMU were
determined.
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Date 2011-06-06
Method Used Waterline measurements

Most Recent Satic
Draft Deter mination

Discussion

Preliminary static draft measurements are
made at the beginning of each leg and as
necessary thereafter, typically every 2 -

3 days and before and after any transfers
of ballast, fuel, and black and gray water.
Static draft for THOMAS JEFFERSON
Is measured using a sight tube located

in lower survey storesin the vicinity of
frame 33. Lower survey storesis not
vented to the atmosphere, and as a result,
air pressure inside the ship can introduce
an error in static draft measurements. As
aresult, avalue of 0.1m was entered into
the CARIS HVF as the uncertainty for
static draft for the ship. Standard practice
IS to open hatches in survey that provide
access to lower survey stores to reduce
the effects of differential air pressure on
the waterline measurements.

Most Recent
Dynamic Draft
Determination

Date

2011-03-25

Method Used

Ellipsoidally Referenced Dynamic Draft
Measurement (ERDDM)

Discussion

For the 2011 field season, the THOMAS
JEFFERSON used an inertially-aided
post-processed kinematic approach
(IAPPK) to determine the dynamic

draft (settlement and squat) for the

ship (S222). This method is called an
ellipsoid-referenced dynamic draft
measurement (ERDDM). The initial test
for the ship occurred on March 30, 2011,
in the Chesapeake Bay, in the vicinity

of Cape Charles City, east of York Spit
Channel. Environmental conditions
(current) led to questionable results. The
ERDDM method was tried again on May
26, 2011. These results were entered into
the ship's HVF as DN089 and have been
used for the entire 2011 field season.
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Figure 1: NOAA Ship THOMAS JEFFERSON

A.1.2 Hydrographic Survey Launch 3101

Name Hydrographic Survey Launch 3101
Hull Number 3101
Description NOAA Ship THOMAS JEFFERSON Hydrographic Survey Launch 1 of 2
Utilization shallow water hydrographic data collection
LOA 31 feet
Dimensions Beam 10.667 feet
Max Draft 5.167 feet
Date 2010-01-13
Performed By National Geodetic Survey (NGS)
Vessel offset measurements were
conducted for HSL 3101 by NGS
personnel. The NGS survey measured
from established benchmarks on the
Most Recent Full vessel back to the reference point,
Satic Survey specifically the cross hairs on top of the
Discussion IMU. From the surveyed benchmarks, the
new RESON 7125SV, SSV'S, and Odom
CV 200 installation offsets were measured
using a steel tape. The Klein 5000 side
scan was surveyed in a similar manner
and offsets for the “heavy-weight” and
“light-weight” systems were recorded.
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Date 2011-02-09
Performed By NGS

Most Recent Partial
Satic Survey

Discussion

NGS performed a partial resurvey of
launches 3101 and 3102 to survey new
POS/MV antenna's with respect to the
vessel reference point. The launches
were in the cradles onboard the ship

at the time of the NGS survey, which
reduced the accuracy and precision of the
measurements. Calibrated Installation
Parameters as calculated by the POS/MV
indicate that the NGS measurements are
within 8cm of the calculated values.

Most Recent Full
Offset Verification

Date

2011-03-08

Method Used

Steel tape to previously established
reference marks on the vessel's hull

Discussion

During the 2010 NGS survey, reference
marks were established at various
locations along the keel and hull of the
launches to facilitate offsets verification.
A stedl tape was used to measure from
reference point of each transducer to one
of the previously established reference
marks. This procedure was used to verify
prior results.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Satic
Draft Determination

Date 2011-02-14

Method Used Waterline measurement
Static draft measurements for HSL 3101
and HSL 3102 are determined using a
sight tube to measure the waterline with

Discussion respect to the reference point on the top

of the IMU. These measurements are
made at the beginning and end of each
working day while the vessel isdead in
the water.
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Most Recent
Dynamic Draft
Determination

Date

2011-03-25

Method Used

Ellipsoidally Referenced Dynamic Draft
Measurement (ERDDM)

Discussion

For the 2011 field season, NOAA

Ship THOMAS JEFFERSON used an
inertially-aided post-processed kinematic
approach (IAPPK) to determine the
dynamic draft (settlement and squat) for
3101 and 3102. This method is called

an ellipsoid-referenced dynamic draft
measurement (ERDDM). This method
was used to determine the dynamic

draft for HSL 3101 as a part of the 2011
Hydrographic Systems Readiness Review
which occurred on March 25, 2011 in the
Elizabeth River.

Figure 2: Hydrographic Survey Launch 3101/3102

A.1.3 Hydrographic Survey Launch 3102

Name Hydrographic Survey Launch 3102

Hull Number 3102

Description NOAA Ship THOMAS JEFFERSON Hydrographic Survey Launch 2 of 2
Utilization shallow water hydrographic data collection
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Dimensions

LOA

31 feet

Beam

10.667 feet

Max Draft

5.167 feet

Most Recent Full
Satic Survey

Date

2010-01-13

Performed By

National Geodetic Survey (NGYS)

Discussion

Vessel offset measurements were
conducted for HSL 3102 by NGS
personnel. The NGS survey measured
from established benchmarks on the
vessel back to the reference point on top
of the IMU in the same manner as the
survey of HSL 3101. From the surveyed
benchmarks, the new RESON 7125SV,
SSVS, and Odom CV 200 installation
offsets were measured using a steel tape.
The Klein 5000 side scan was surveyed
inasimilar manner and offsets for the
“heavy-weight” and “light-weight”
systems were recorded.

Most Recent Partial
Satic Survey

Date

2011-02-09

Performed By

NGS

Discussion

NGS performed a partial resurvey of
launches 3101 and 3102 to survey new
POS/MV antenna's with respect to the
vessel reference point. The launches
were in the cradles onboard the ship

at the time of the NGS survey, which
reduced the accuracy and precision of the
measurements. Calibrated Installation
Parameters as calculated by the POS/MV
indicate that the NGS measurements are
within 10cm of the calculated values.
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Date 2011-03-08
Method Used Steel tape to previously established
reference marks
During the 2010 NGS survey, reference
marks were established at various
Most Recent Full

Offset Verification

Discussion

locations along the keel and hull of the
launches to facilitate offsets verification.
A steel tape was used to measure from
phase center of each transducer to one

of the previously established reference
marks. This procedure was used to verify
prior results.

Most Recent Partial
Offset Verification

Partial offset verification was not performed.

Most Recent Satic
Draft Determination

Date 2011-02-14

Method Used Waterline Measurement
Static draft measurements for HSL 3101
and HSL 3102 are determined using a
sight tube to measure the waterline with

Discussion respect to the reference point on the top

of the IMU. These measurements are
made at the beginning and end of each
working day while the vessel isdead in
the water.
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Most Recent
Dynamic Draft
Determination

Date

2011-03-25

Method Used

Ellipsoidally Referenced Dynamic Draft
Measurement (ERDDM)

Discussion

For the 2011 field season, NOAA

Ship THOMAS JEFFERSON used an
inertially-aided post-processed kinematic
approach (IAPPK) to determine the
dynamic draft (settlement and squat) for
3102. This method is called an ellipsoid-
referenced dynamic draft measurement
(ERDDM). The draft values were not
updated in the HVF for 3102 in atimely
manner, and therefore dynamic draft
values from the 2010 season were
retained for the 2011 season. Subsequent
analysis showed that 2010 values agreed
with the 2011 ERDDM values within
3cm for the entire range of survey speed,
and therefore it was determined that the
values retained from the 2010 season
were adequate and additional processing
with updated values from the ERDDM
test were not warranted.

Figure 3: Hydrographic Survey Launch 3101/3102

A.2 Echo Sounding Equipment

10
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A.2.1 Side Scan Sonars

A.2.1.1 Klein 5000

Manufacturer

Klein

Model

5000

Description

High speed, high resolution side scan sonar towfish (exclusively towed): The KLEIN 5000
high speed, high-resolution side-scan sonar (SSS) system is a beam-forming acoustic
imagery device with an operating frequency of 455 kHz and vertical beam angle of 40°.
The KLEIN 5000 system consists of a KLEIN 5500 towfish, a Transceiver/Processing
Unit (TPU), and a computer for user interface. Stern-towed units also include atow cable
telemetry assembly. There are two configurations for data acquisition using the KLEIN
5000 system: stern-towed and hull-mounted. S-222 uses exclusively towed SSS, HSL 3101
is ahull-mount configuration, HSL 3102 can be converted from hull-mounted to towed as

required.

The KLEIN 5000 system is distinct from other commercially-available side scan sonars

in that it forms 5 simultaneous, dynamically-focused receiver beams per transducer face.
Thisimproves along-track resolution to approximately 20cm at the 100m range scale, even
when acquiring data at up to 10 knots. Across-track resolution istypically 7.5cm at the
100m range scale. The achievable 20cm resolution meets the NOAA Hydrographic Surveys
Specifications and Deliverables Manual (HSSDM) requirements for object detection.

Digital datafrom the KLEIN 5000 TPU is sent directly to the acquisition computer for
display and logging by KLEIN SonarPro software. Raw digital side scan data from the
KLEIN 5000 is collected in SDF file format and maintained at full resolution with no
conversion or down sampling techniques applied. These files are archived to the raw data
storage drives at the end of each linefor initial processing and quality control review

Towfish positioning with respect to the vessel reference point is provided by CARIS HIPS
using cable-out values recorded in the Sonar Pro SDF files. HIPS uses cable-out and towfish
depth to compute towfish positions. The towfish position is calculated from the position of
the tow point using the cable-out value received by SonarPro from the cable-payout meter,
the towfish pressure depth (sent via a seria interface from the KLEIN 5000 computer TPU
to the SonarPro software ), and the Course Made Good (CMG) of the vessel. This method
assumes that the cable isin a straight line therefore no catenary agorithm is applied at the
time of acquisition. During processing, CARIS SIPS applies a 0.9 coefficient to account for
the catenary.

When in the towed configuration, the north and east velocity vectors are filtered to calculate
the ship’'s CMG. The CMG is used to determine the azimuth from the tow-block to the

side-scan towfish. The position for the side-scan towfish is computed based on the vessel’s

11
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heading, the reference position (POS/IMV IMU), the measured offsets (X, Y, and Z) to the
tow point, height of the tow point above the water, Course Made Good, and cable-out.
This calculated towfish position is sent to the sonar data collection system in the form of a
GGA (NMEA-183, National Marine Electronics Association, Global Positioning System
Fix Data String) message where it is merged with the sonar data file. Cable adjustments
are made using aremote winch controller located in acquisition in order to maintain
acceptable towfish altitudes and sonar record quality. Changes to the amount of cable-out
are automatically saved to the SonarPro SDF.

Towfish altitude is maintained between 8% and 20% of the range scale in use (e.g. 4m-10m
@ 50m range scale), when conditions permit. For equipment and personnel safety as well
as safe vessel maneuverability, data may have been collected at towfish altitudes outside
the 8% to 20% of the range over shoa areas and in the vicinity of charted obstructions
or wrecks. In some regions of the survey areas, the presence of a significant density
layer required that the altitude of the towfish be maintained outside the 8% to 20 % of
the range to avoid refraction in the sonar data that would mask small targets in the outer
sonar swath range. When the towfish altitude was either greater than 20% or less than 8%,
periodic confidence checks on linear features (e.g. trawl scars) or geological features (e.g.
sand waves or sediment boundaries) were made to verify the quality of the sonar data.
Confidence checks ensure the ability to detect one-meter high objects across the full sonar
record range.

Another feature that affects the towfish altitude is the use of a K-wing depressor. The K-

wing depressor is attached directly to the towfish and serves to keep it below the vessel
wake, even in shallow, near-shore waters at slow survey speeds. The use of the K-wing
reduces the amount of cable payout, which in turn reduces the positioning error of the
towfish. Another benefit to less cable out is increased maneuverability of the shipin
shallow water. Less cable out reduces the need to recover cable prior to turning for the next
survey line, permitting tighter turns and increased survey efficiency.

Side scan data files break automatically every 15 minutes and manually at the completion of
asurvey line. Each lineis given aunigue file name based on the time acquisition began on
each line.

Klein TPUs are interchangeabl e on the ship and launches. TPUs are occasionally swapped
from one platform to another for troubleshooting or as necessary when factory maintenance
isrequired. Klein 5000 light-weight and heavy-weight towfish are also interchangeable on
al platforms. The standard configuration isto hull mount the light weight towfish on the
launches and to tow the heavy weight towfish from the ship.

Serial
Numbers

Vessel Installed

S222
On

TPU g/n 135/136/137

Towfish s/n 280
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Freguency 455 kilohertz
Resolution 20 centimeters

Along Track Min Range 50 meters
Resolution

Specifications Max Range 150 meters
Across Tr ack 7.5 centimeters
Resolution
Max Range
Sale 150 meters

Manufacturer

Calibrations

Manufacturer calibration was not performed.

Y

Figure 4: Klein 5000
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Figure 5: Sde Scan Towfish Position Calculations
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A.2.1.2 Klein 5000 Light-weight

Manufacturer

Klein

Model

5000 Light-weight

Description

High speed, high resolution side scan sonar towfish (hull mounted): Aboard both

survey launches, the lightweight or heavyweight Klein 5500 towfish can be mounted

to an aluminum sled using omega brackets. Positioning of the hull mounted towfishis
determined by entering the X, Y, Z position of the towfish as the towpoint and a layback
value of zero. Otherwise, the system is processed the same as the towed configuration.

The hull-mounted configuration is normally used in depths of twenty meters or less, per
the HSSDM. Aboard Launch 3101 and 3102, sidescan may be collected concurrently with
ODOM Echotrac CV-200 vertical beam bathymetry or with Reson 7125-SV multibeam
bathymetry with the addition of aBNC to BNC coax cable from the Klein TPU Trigger 1
Out to the Reson Trigger In. When SSSYMBES acquisition isin use, the ping rate for both
systems is determined by the range scale in use on the Klein 5000. SSS/MBES acquisition
will be discussed further in the Reson 7125-SV section.

Launch acquisition of SSS with concurrent MBES bathymetry only occurred during OPR-
B363-TJ-11 on H122296 and H12298 during the 2011 field season. Logging SSS with
concurrent MBES on the launches frequently resulted in timing errors. The volume of

data arriving at the acquisition computer from each of the survey components exceeded the
acquisition computer's ability to process the data, resulting in dropped data packets. The
dropped data packets manifests as a mismatch between bathymetry and the vessel motion.
For this reason, SSS with concurrent bathymetry is not a standard mode of operation on the
launches.

Serial
Numbers

Vessel Installed
On

3101/3102

TPU s/n 135/136/137

Towfish §n 322/319

Soecifications

Frequency 455 kilohertz

Resolution 20 centimeters

Along Track

Resolution 50 meters

Min Range

Max Range

Across Track

. 7.5 centimeters
Resolution

Max Range

Sale 150 meters

Manufacturer
Calibrations

Manufacturer calibration was not performed.
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Figure 6: Sde Scan Hull Mounted on 3101/3102

A.2.2 Multibeam Echosounders

A.2.2.1 RESON 7125-ROV

Manufacturer

RESON

Model

7125-ROV

Description

Shallow water multibeam sonar: The RESON 7125 forms 256 beams and can
be set to interpolate to 512 beams. The RESON 7125 can also be set to acquire
equi-distant or equi-angular beam spacing. Each beam in the receive array has a
0.5° across-track resolution and 1° along-track resolution. The RESON 7125 has
amaximum ping rate of 50 Hz and can achieve afull swath width to a depth of
~100m. Standard operating procedure on THOMAS JEFFERSON isto acquire 512
beam, equi-distant bathymetry. Adaptive gates are used to assist in filtering noise
from the water column. Adaptive gates are usually set at 10% of the nadir depth and
nadir search gates are used to help eliminate surface noise and deep fliers in the data.
Range scale is either adjusted manually or by "autopilot”" settings that are tuned
specifically for each survey area. Autopilot settings can control power, gain, range
scale, absorption, spreading, and pulse length.

The sonar contribution to the total propagated error is computed using parameters
provided by the manufacturer and distributed with Caris HIPS. The RESON 7125
performs active beam steering to correct for sound velocity at the transducer
head using an Applied Microsystems L TD Sound Velocity and Temperature

15
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Smart Sensor. This sensor will be discussed in more detail in the Sound Vel ocity

Equipment Section.

Vessel Installed On S222
Processor §/n 50357
Transceiver gn 61206
Serial Numbers Transducer §/n 1908203
Receiver gn 808042
Projector 1 9/n TC 2160
Projector 2 §/n None
Freguency 400 kilohertz
Along Track 1 degrees
Beamwidth 9 ~
Across Track | 0.5 degrees
Max Ping Rate 50 hertz
Beam Spacing
B ] Mode NIA
Specifications eam Spacing NUmber of
512
Beams
Max Swath Width 128 degrees
Depth Resolution 5 millimeters
) Mangfacturer 200 meters
Depth Rating Specified
Ship Usage 100 meters
Manufacturer I
L Manufacturer calibration was not performed.
Calibrations
Vessel Installed On S222 S222
System Accuracy Methods Patch Test Patch Test
Tests Results Patch test results for DN 090 can be | Patch test results for DN232 can be
found in Appendix A.2.1. found in Appendix A.2.2.
Shippets Sonar has snippets logging capability.
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Figure 7: 7125 Transducer Mount on THOMAS JEFFERSON

A.2.2.2 RESON 7125-SV1

Manufacturer

RESON

Model

7125-SV1

Description

Dual Frequency multibeam echo sounder: The RESON 7125-SV system aboard
Launches 3101, 3102 are installed on a RESON Seabat 7125 mounting bracket
deployed on aretractable arm from the hull. The RESON 7125-SV forms 256 beams
and can be set to interpolate to 512 beams in the recelve array and can be set to
acquire equi-distant or equi-angular beam spacing. Standard operating procedure on
THOMAS JEFFERSON isto acquire 512 beam, equi-distant bathymetry. The 400
kHz frequency has a 0.54° across-track resolution and 1° along-track resolution. The
200 kHz frequency has a 1.1° across-track resolution and 2.2° along-track resolution.
The RESON 7125-SV has a maximum ping rate of 50 pings and can maintain a
full swath width in depths of 1-75 m for the 400 kHz, and 1-150 m for the 200 kHz
systems. Adaptive gates are used to assist in filtering noise from the water column.
Adaptive gates are usually set at 10% of the nadir depth and nadir search gates are
used to help eliminate surface noise and deep fliersin the data. Range scaleis either
adjusted manually or by "autopilot" settings that are tuned specifically for each
survey area. Autopilot settings can control power, gain, range scale, absorption,
spreading, and pulse length.

The sonar contribution to the total propagated error is computed using parameters
provided by the manufacturer and distributed with Caris HIPS.
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The RESON 7125-SV performs active beam steering to correct for sound velocity at
the transducer head using a RESON Sound Velocity Probe (SVP) 70. This sensor
will be discussed in more detail in the Sound Velocity Equipment Section.

The RESON 7125-SV can be configured for roll stabilization. In roll-stabilized
mode, the sonar can operate in environments with up to +/- 10 degrees of roll
without degrading system performance. Standard operating procedure on THOMAS
JEFFERSON isto acquire datain the roll-stabilized mode.

Notable RESON7125-SV equipment changes. The Reson 7125-SV units on 3101
and 3102 were new equipment installations for 2010 field season; new .hvf files
were created. Over the course of the 2011 season, receiver cables for the new
Reson7125-SV units have failed on three separate occasions due to micro-fractures
inthe wires. These receiver cables have been replaced by a newer design which has
endured the rotational stresses of a pivot mount significantly better than previous
designs.

Components from the RESON 7125-SV units are interchangeable and both units
have been deployed on each launch at least once during the 2011 field season. Patch
tests are acquired anytime a receiver or projector are removed and replaced on a
launch.

Vessel Installed On 3101 3102
Processor s/n 1812018 1812031
Transceiver gn 1812018 1812031
Serial Numbers Transducer §/n N/A N/A
Receiver g/n 1409071/0309006 1409071/0309006
Projector 1 /n 2308097/2208005 2308097/2208005
Projector 2 9/n 4408356/2909185 4408356/2909185
Freguency 400 kilohertz 200 kilohertz
) Along Track 1.1 degrees Along Track 2.2 degrees
Beamwidth
Across Track  |0.54 degrees AcrossTrack  |1.1 degrees
Max Ping Rate 50 hertz 50 hertz
' ||\3/|eoa(;2 Spacing Equiangular l\B/Ie:dn; Spacing Equidistant
Soecifications Beam Spacing Number of Number of
Bearms 512 Beams 256
Max Swath Width 140 degrees 140 degrees
Depth Resolution 6 millimeters 6 millimeters
Depth Rating I\S/Ii.rgﬂﬁzcéturer 200 meters g/lpz;r;;ffiigturer 300 meters
Ship Usage 100 meters Ship Usage 250 feet
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Manufacturer o
. . Manufacturer calibration was not performed.
Calibrations
Vessel Installed On 3101 3101 3102 3102
Methods Patch Test on Patch Test on Patch test on DN | Past test on DN
DNO059 DN 232 056 233
Patch test results Patch test results
can befoundin can befoundin
Appendix A.2.3. Appendix A.2.4.-
- Retained patch Retained patch
values from values from Patch test results
System Accuracy 2010 field season | See HVF for 2010 field season .
can befoundin
Tests because the 2011 | patch test results | because the 2011
) . 7 |A.2.5. - Values
Patch results did |- Valuesapplied |Patch results did ;
Results applied to the
not resolvethe [totheHVFand | not resolve the
. . HVF and used
biases any better |used for OPR- biases any better for OPR-B363-
than the 2010 B363-TJ11 than the 2010 THA
values. Retaining values. Retaining
the 2010 values the 2010 values
until amore until amore
suitable patch suitable patch
areaisavailable. areaisavailable.
Sippets Sonar has snippets logging capability.

Figure 8: 7125-SV1 Housing on Launch 3101/3102
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A.2.2.3Kongsberg Simrad EM 1002

Manufacturer Kongsberg
Model Simrad EM 1002
Description S222, Multibeam Echosounder, Processor, Transducer
Vessel Installed On S222
Processor s/n 227
Transceiver §n 382
Serial Numbers Transducer s/n 267
Receiver gn N/A
Projector 1 9/n N/A
Projector 2 9/n N/A
Frequency 95 kilohertz
Along Track 1.5 degrees
Beamwidth 9 eg
Across Track 2 degrees
Max Ping Rate 10 hertz
Beam Spacing -
; . Mode Equidistant
Secifications eam Spacing Number of
111
Beams
Max Swvath Width 150 degrees
Depth Resolution 8 centimeters
Manufacturer
- 1000 meters
Depth Rating Specified
Ship Usage 1000 meters
Manufacturer I
L Manufacturer calibration was not performed.
Calibrations
stem Accura
A cy System accuracy test was not performed.
Tests
Sippets Sonar has snippets logging capability.

A.2.3 Single Beam Echosounders
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A.2.3.1 Odom Echotrac CV-200

1

1

1

Manufacturer Odom
Model Echotrac CV-200
Shallow water single beam echo sounder: The Echotrac CV-200 is a dual-frequency
digital-recording echosounder system with a digital recorder. The systems high-
frequency setting is 200 kHz; low-frequency is 24 kHz. It is hull-mounted on HSL
3101and 3102.
Description On Launches 3101 and 3102, the transducer is mounted on the port side forward of
the retractable arm that accommodates the RESON 7125-SV. Theinstallation of the
Odom on Launch 3101 and 3102 allows simultaneous acquisition of KLEIN 5000
side-scan with general survey-grade bathymetry when the ODOM is operated in
either low- or high-frequency mode.
Vessdl 3101 3102
Serial Numbers Processor §/n 003260 002917
Transducer s/n XXXXXXXX XXXXXXXX
Freguency 200 kilohertz 24 kilohertz
Along Track 4 degrees Along Track 20 degrees
Beamwidth
Across Track |4 degrees Across Track 20 degrees
Specifications Max Ping Rate 20 hertz 20 hertz
Depth Resolution 1 centimeters 1 centimeters
Manufacturer Manufacturer
- 200 meters . 1500 meters
Depth Rating Secified Soecified
Ship Usage 150 meters Ship Usage 1000 meters
Manufagturer Manufacturer calibration was not performed.
Calibrations
Vessel Installed On 3101 3101 3102 3102
SystemAccuracy || Methods Bar Check Reference Bar Check Reference
Tests surface Surface
Results Meets IHO Order | Meets IHO Order | Meets IHO Order | Meets IHO Order

1
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Figure 9: Odom Vertical Beam on 3101 / 3102

A.2.4 Phase M easuring Bathymetric Sonars

No phase measuring bathymetric sonars were utilized for data acquisition.

A.2.5 Other Echosounders

No additional echosounders were utilized for data acquisition.
Additional Discussion

An Applanix Landmark Marine laser scanner was used during OPR-E350-TJ-11 on survey H12282. The
systemisacClass| laser product with a maximum range of 1500m. The system has a raw range accuracy of
7mm@2100m and raw positional accuracy of 8mm@2100m. The system is coupled with an Applanix Pos/
MV 420 ver 4 GNSSinertial navigation system. The components were mounted to an auminum mounting
bracket and all offsets for the components were surveyed to the reference point for the unit. With this
modular design the system can mobilize and commence surveying in a matter of hours. The Landmark
Marine system was used to acquired high resolution x,y,z plus intensity laser data on shoreline features to
support a 1:10,000 scale chart product of Norfolk Harbor. Positioning was obtained by post-processing the
GNSS data with Applanix In-Fusion Smart Base processing. The resulting SBETs were parsed with the
raw laser datato create processed x,y,z + Intensity files referenced to the ellipsoid using a proprietary data
parser provided by the manufacturer. In Caris BDB, the ellipsoid-referenced point cloud data were shifted
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to MLLW using aVDATUM separation model provided with the Project Instructions for OPR-E350-TJ-11.
The point cloud data were then used to confirm or disprove charted shoreline features. The Landmark
Marine system is not discussed further in other sections of this DAPR. No additional systems accuracy
checks were made aside from comparing the features from the laser data to orthoimagery provided with the
project instructions and with sonar datafrom H12282.

Figure 10: Landmark Marine Laser Scanner System - image courtesy of geoconnexion.com

A.3 Manual Sounding Equipment

A.3.1 Diver Depth Gauges

No diver depth gauges were utilized for data acquisition.

A.3.2Lead Lines

Manufacturer Lead Line fabricated by ship'sforce
Model N/A

Description Standard Lead Line

Serial Numbers WH-4
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Serial Number WH-4
Date 2011-03-02
Calibrations Thelead line was calibrated against a steel tape in the parking lot of the
Procedures NOAA Marine Operations Center - Atlantic, Norfolk, VA 23510 on
March 2, 2011. The calibration/accuracy check was performed by SST
Lewit and ST Glomb.
Accuracy Checks No accuracy checks were performed.
Correctors From Om - 15m, no corrections are needed, at 16m, a-1 cm corrector must be
applied. The lead line does not extend beyond 16m.
Non-Sandard .
Non-standard procedures were not utilized.
Procedures

A.3.3 Sounding Poles

No sounding poles were utilized for data acquisition.

A.3.4 Other Manual Sounding Equipment

No additional manual sounding equipment was utilized for data acquisition.

A.4 Positioning and Attitude Equipment

A.4.1 Applanix POS/IMV

Manufacturer

Applanix

Model

POS/MV Model 320 v.4.

Description

The POS/MV 320 system includes dual GPS antennas, an inertial measurement

unit (IMU), and data processor (PCS). The IMU measures linear and angular
accelerations corresponding to the major motions of the vessel (heave, pitch, roll,
yaw) and inputs this data to the PCS, where it is combined with a GPS position
determined by carrier-phase differential measurements to give the final position
solution. GPS positions are subject to short-period noise, but are stable over time
and do not drift. IMU datais not subject to short-period noise, but will drift over
time. The POS/MV uses atightly-coupled solution which uses the IMU datato
buffer the short-period noise from the GPS solutions and utilizes the GPS solutions
to prevent IMU drift over time. The result of this tightly-coupled solution is attitude
data (Pitch, Roll, and Y aw) with accuracies of 0.02° and horizontal positioning
accuracy of 2m or better.
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Manufacturer Applanix
Model POS/MV 320 v.4
The POS Computer System (PCS) receives data from the GPS antennas
- and IMU and processes the information into a tightly-coupled solution.
Description

The PCS then outputs a variety of data streamsto other devicesvia
Ethernet, serial communication, and coaxia cable.

PCS
Firmware Version S222 - 2.8-7; 3101 - 2.8-7; 3102 - 2.5-7
Software Version S222 - 3.42; 3101 - 5.01; 3102 - 5.03
Vi Install
essel Installed S222 3101 3102
Serial Numbers On
PCSs/n PCS-2321 PCS-2320 PCS-2562
Manufacturer Applanix
Model POSM/V 320v.4
Survey-grade Inertial Measurement Unit. The IMU measures linear
and angular accelerations corresponding to the major motions of the
vessel (heave, pitch, roll, yaw) and inputs this data to the PCS, where it
Description is combined with a GPS position determined by carrier-phase differential
measurements to give the final position solution. The POS/MV position
solution is not sensitive to short-period noise, but its accuracy may decay
IMU rapidly over time.
Vessel Installed
S222 3101 3102
Serial Numbers On
IMU s/n IMU-146 IMU-352 IMU-356
IMU s/n IMU-146 IMU-352 IMU-356
Certification ificati
gjtte' aton 1 o010-02:02  |2010:0202  |2010-02-02
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Manufacturer Trimble Navigation LTD
Model Zephyr
Description L1/L2 carrier-phase antennas
Vessel Installed |55 3101 3102
On
Antenna s/n 4526A59117 4526A59093 4617A 68061
Serial Numbers Port or
Port Port Port
Sarboard
Primary or . . .
Primary Primary Primary
Secondary
Antennas
Manufacturer Trimble Navigation LTD
Model Zephyr
Description L1/L2 carrier-phase antennas
Vi |
essel Installed S222 3101 3102
On
Antenna g/n 44526A59133 4533A59352 4624A70252
Serial Numbers
Port or Starboard Starboard Starboard
Sarboard
Primary or
Secondar Secondar Secondar
Secondary y y y
) . Vessel S222 3101 3102
GAMS Calibration
Calibration Date 2011-03-30 2011-02-28 2011-02-25
Configuration Vessel S222 3101 3102
Reports Report Date 2011-09-20 2011-10-21 2011-10-21

26

Figure11: POSM/V 320 v.4




2011 DAPR Version 1.0

NOAA Ship Thomas Jefferson

A.42 DGPS
THOMAS JEFFERSON, Survey Launch 3101, and Survey Launch 3102 are each
equipped with Trimble DSM212L. DGPS receivers. The DSM212L includes a 12-
Description channel GPS receiver capable of receiving external RTCM correctors from a shore-
based reference station. The DSM212L receivers are used to receive differential
correctors only and not used for actual positioning.
Manufacturer Trimble Navigation Limited
Model MSK H-field loop
Description Differential Radio Beacon Receiver
Antennas
Vessel
S222 S222 3101 3102
Serial Numbers Installed On
Antenna s/n  |0220227516 |0220159716 |0220243252 |0220168291
Manufacturer Trimble Navigation LTD
Model DSM212L
12-channel GPS receiver capable of receiving external RTCM correctors
Description from a shore-based reference station. The DSM212L receivers are used to
Receivers receive differential correctors only and not used for actual positioning.
Firmware Version 20
Vessd
S222 S222 3101 3102
Serial Numbers Installed On
Antenna g/n  |0220227516 |0220159716 |0220243252 |0220168291

A.4.3 Trimble Backpacks

Trimble backpack equipment was not utilized for data acquisition.
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A.4.4 Laser Rangefinders

No laser rangefinders were utilized for data acquisition.

A.4.5 Other Positioning and Attitude Equipment

No additional positioning and attitude equipment was utilized for data acquisition.

A.5 Sound Speed Equipment

A.5.1 Sound Speed Profiles

A51.1CTD Profilers

A.5.1.1.1 Sea Bird Electronics SBE19/19+ CTD Profilers

Manufacturer

Sea Bird Electronics

Model

SBE19/19+ CTD Profilers

Description

There are four Seabird Electronics CTDs aboard the THOMAS JEFFERSON. The
ship hasa SBE19 and a SBE19+V 2, and launches 3101 and 3102 have a SBE 19+
models.

The SBE19 is designed to measure conductivity, temperature, and pressure in marine
or fresh water environments. It can operate in Profiling mode or Moored mode.
Profiling mode is used exclusively aboard the ship. The systemis configured for a
sampling rate of 0.5 seconds. The SBE 19 is powered by 9 D-size alkaline batteries.
The on-board memory is 1024 kilobytes CMOS static RAM, which can record
24 hrs of conductivity, temperature, and pressure data at the 0.5 second sample
rate. The SBE19 is capable of CTD profiling at depths from 0-3,400m. Post-
calibration drift is expected to be 0.02 °C yr-1, 0.012S m-1 yr-1, and 4.5 psiayr-1 for
temperature, conductivity, and pressure, respectively. The SBE19 is deployed by
hand or by using the DT Marine Oceanographic winch for ship-based acquisition.

During the 2011 field season, the SBE19 was only used for CTD comparisons
aboard the ship and was not used to acquire profiles for corrections to echosounder
data.
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Seabird Electronics SBE-19 CTD+ units were used to collect sound speed profile
(SSP) data from Launches 3101 and 3102.

22 - SBE -
. Vessel Installed On S222 - SBE-19 S2 S 3101 - SBE 19+ |3102 - SBE 19+
Serial Numbers 19+ V2
CTD gn 285 6667 4486 4487
CTD g/n 285 6667 4486 4487
. . Date 2011-09-10 2011-09-20 2011-09-20 2011-09-20
Calibrations
Procedures Manufacturer Manufacturer Manufacturer Manufacturer
Calibration Calibration Calibration Calibration

A.5.1.2 Sound Speed Profilers

A.5.1.2.1 Brooke Ocean Technology MVP 100

Manufacturer

Brooke Ocean Technology

Model

MVP 100

Description

A Brooke Ocean Technology Moving Vessel Profiler (MVP) with an Applied
Microsystems Smart Sound Velocity and Pressure (SV & P) sensor or a Seabird
Electronics SBE-19 CTD were used to collect sound speed profile (SSP) data
from THOMAS JEFFERSON. The Moving Vessdl Profiler (MVP) is a self-

contained profiling system capable of sampling water-column profiles to 100m depth.

MV P-100 was mounted to the port quarter. The MV P consists of a computer-
controlled high-speed hydraulic winch, a cable metering, over-boarding and docking
system, a conductor cable and a streamlined free-fall fish (FFF) housing an Applied

Microsystems “time of flight” SV& P Smart Sensor (see SV& P below) . The system
as configured aboard the THOMAS JEFFERSON collects vertical profiles of sound
velocity datawhile the ship is underway at survey speed. The unit islocated on
the fantail and controlled remotely from the ship’s acquisition room. The MVPis
capable of importing its data directly into the Kongsberg SSIMRAD EM 1002 muilti-
beam echosounder (MBES) at the time of acquisition. When using MVP castsin
conjunction with the RESON 7125 MBES, sound velocity datais processed using

Velocwin software, then applied in CARIS HIPS during post processing.

Serial Numbers

Vessel Installed On S222 S222 S222

Sound Speed Profiler gn | 4988 5340 7591
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Sound Speed Profiler §/n | 4988 5340 7591
Calibrations Date 2011-01-26 2011-01-26 2011-04-28
Procedures Manufacturer Manufacturer Manufacturer
Cdlibration Cdlibration Cadlibration
Figure 12: MVP 100 on S-222
A.5.2 Surface Sound Speed

A521AML AML Smart SV&T Probe

Manufacturer AML
Model AML Smart SV&T Probe

The AML Smart SV&T Probe is areal-time time-of-flight sound velocimeter and
Description thermistor sensor. The manufacturer-specified sound velocity accuracy is 0.02 m/s

and temperature accuracy is0.03 °C. Empirical observations of drift show a sound
velocity drift of approximately 0.5 m/s/yr and temperature drift of approximately
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0.05 °Clyr.

Aboard THOMAS JEFFERSON, the AML Smart SV&T probeis

mounted in an insulated sea chest in the sonar void. Sea surface temperature and
sound velocity values are output in real-time to the SSIMRAD EM 1002 and RESON
7125 systems at arate of 10 Hz and are recorded in the raw Hypack .hsx files.

. Vessel Installed On S222 S222
Serial Numbers
Sound Speed Sensor §/n 4823 5649
Sound Speed Sensor §/n | 4823 5649
Calibrations Date 2011-09-10 2011-11-23
Procedures Manufacturer Calibration Manufacturer Calibration

A.5.2.2 Reson SV-71

Manufacturer Reson

Model SVv-71

Description

. Vessel Installed On 3101 3102

Serial Numbers
Sound Speed Sensor s/n | 2008044 2008027
Sound Speed Sensor §/n (2008044 2008027
Date 2010-11-24 2011-03-03

Calibrations Three data-point, side-by-side Three data-point, side-by-side
Procedures comparisons to known calibrated lab | comparisons to known calibrated lab

instruments. instruments.

A.6 Horizontal and Vertical Control Equipment

A.6.1 Horizontal Control Equipment

No horizontal control equipment was utilized for data acquisition.

A.6.2 Vertical Control Equipment
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A.6.2.1 Water Level Gauges

No water level gauges were utilized for data acquisition.

A.6.2.2 Leveling Equipment

Manufacturer Lietz / Sokkisha

Model B1 Automatic Level

Description TIDES & LEVELING EQUIPMENT
Serial Numbers 7423

Calibrations No calibrations were performed.

Kukkamaki No Kukkamaki procedures were performed.
Manufacturer Carl Zeiss

Model Ni 2 Level

Description TIDES & LEVELING EQUIPMENT
Serial Numbers 20606

Calibrations No calibrations were performed.

Kukkamaki No Kukkamaki procedures were performed.

A.7 Computer Hardwar e and Software

A.7.1 Computer Hardware

Manufacturer Kongsberg

Model EM HWS 10

Description Survey, rack mounted
Computer s/n 227

Serial Numbers Operating System Windows X P Profesional 2002
Use Acquisition

Manufacturer Dell

Model Precision T3400

Description CARIS Survey Software, rack mounted-PC
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Computer s/n 6705VK1
Serial Numbers Operating System Windows XP Profesional 2002
Use Acquisition
Manufacturer RESON
Model 7KV 21131
Description STBD 7125, Rack-PC S222 Acquisition Monitor
Computer s/n 50357
Serial Numbers Operating System Windows XP Professional 2002
Use Acquisition and Processing
Manufacturer Ddll
Model Precision T3400
Description Klein Back-up (SSS1S1S)
Computer s/n GQG2VK1
Serial Numbers Operating System Windows X P Professional 2002
Use Acquisition
Manufacturer Industrial Computer Inc.
Model 4UX-208-X7DAL-E
Description Survey 3101, used for Hypack & Hysweep
Computer s/n NM8AS31197
Serial Numbers Operating System Windows XP Professional 2002
Use Acquisition
Manufacturer Dell
Model 4U X-208-X7DAL-E
Description Survey 3102, used for Hypack & Hysweep
Computer §/n OM8645147
Serial Numbers Operating System Windows X P Professional 2002
Use Acquisition
Manufacturer Dell
Model Workstation PWS 650
Description Processor Survey Chief, plot room
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Computer s/n 4ADVFZF1

Serial Numbers Operating System Windows X P Professional 2002
Use Processing

Manufacturer DELL

Model Workstation PWS 650

Description Processor 6, plot room
Computer s/n 4IKBZK1

Serial Numbers Operating System Windows X P Professional 2002
Use Processing

Manufacturer Del

Model Workstation PWS 650

Description Processor 7, plot room
Computer s/n 6JKBZK1

Serial Numbers Operating System Windows X P Professional 2002
Use Processing

Manufacturer Dl

Model Precision T3400

Description Survey -4, plot room
Computer s/n 8JKBzK1

Serial Numbers Operating System Windows X P Professional 2003
Use Processing

Manufacturer Ddll

Model Precision T3400

Description Survey -3, plot room
Computer §/n CIKBzK1

Serial Numbers Operating System Windows X P Professional 2003
Use Processing

Manufacturer Dell

Model Precision T3400

Description Survey -2, plot room
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Computer s/n 9JKBZK1
Serial Numbers Operating System Windows X P 2002
Use Processing
Manufacturer Dell
Model Precision T3400
Description Survey-1, plot room
Computer s/n DDVFZF1
Serial Numbers Operating System Windows X P Professional 2003
Use Processing
Manufacturer Del
Model Percision T3400
Description FOO Desktop
Computer s/n CD#0001766903
Serial Numbers Operating System Windows X P 2002 sp3
Use Processing
Manufacturer Dl
Model Latitude D800
Description FOO Laptop
Computer s/n CD#0000398722
Serial Numbers Operating System Windows X P 2002
Use Processing

A.7.2 Computer Software

Manufacturer Caris

Software Name Bathy Database
Version 3.2

Service Pack

Hotfix

Installation Date 2011-09-14
Use Processing
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Base Editor is used for feature preparation and compilation, surface review, and chart

Description :
comparison.

Manufacturer Caris

Software Name HIPS & SIPS

Version 7.0

Service Pack

Hotfix

Installation Date 2011-09-14

Use Processing
CARIS HIPS (Hydrographic Information Processing System) is used for al initial
processing of multibeam and vertical beam echosounder bathymetry data, including
tide, sound velocity, and vessel offset correction and data cleaning. CARIS HIPS
uses statistical modeling to create Bathymetry with Associated Statistical Error

Descrintion (BASE) surfaces in one of three ways. swath-angle weighted grids, uncertainty-

P weighted grids, and Combined Uncertainty and Bathymetry Estimator (CUBE)
algorithm grids. Creation of grids as bathymetric productsis discussed in section B
of thisreport. CARIS SIPS (Side-scan Information Processing System) is used for
all processing of side-scan sonar imagery, including cable layback correction, slant
range correction, contact selection, towpoint entry, and mosaic generation.

Manufacturer HSTP

Software Name Pydro

Version 11.9

Service Pack

Hotfix

Installation Date 2011-09-14

Use Processing
HSTP PYDRO is aprogram for the correlation and classification of side-scan sonar
and multibeam bathymetry features and for the creation of preliminary smooth
sheets. Multibeam features (designated soundings), side-scan sonar contacts, and
detached positions are analyzed, grouped, and assigned S-57 classifications. High
resolution BASE surface data is entered into the program and excessed to survey
scale. Thefinal product isaPreliminary Smooth Sheet file (PSS), which is delivered

Description to the Atlantic Hydrographic Branch as part of the final submission package. Pydro

Versions 7.3 and later have functionality for TCARI installed. TCARI is described
in detail in the section "Corrections to Echo Soundings, Tides and Water Levels".
The TCAR!I filefor the area (when applicable) is received from NOS and loaded into
Pydro along with the predicted, observed, or verified tide files for the corresponding
stations. The use of TCARI is specified in the Project Instructions. Pydro is also used
for chart comparisons, generation of chartlets, generation of Danger to Navigation
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reports, generation of appendices to the Descriptive Report, compilation of survey
statistics, and generation of standard NOAA forms such as the Descriptive Report
cover sheet.

Manufacturer Maplinfo
Software Name MI Professional
Version 10

Service Pack

Hotfix

Installation Date 2011-09-14
Use Processing

Maplnfo Professional is the Geographic Information System (GIS) software package

Description used aboard THOMAS JEFFERSON. Mapinfo is used for sheet management, line
planning, final data analysis, and creating end-user plots.

Manufacturer IVS

Software Name Fledermaus

Version

Service Pack

Hotfix

Installation Date 2011-09-14

Use Processing

Description Fledermaus is used for processing water column, or "midwater" multibeam data.
Manufacturer HSTP

Software Name Velocipy

Version 11.10

Service Pack

Hotfix

Installation Date 2011-09-14

Use Processing

Description

HSTP Velocwin is a program for the processing of sound velocity casts. This
program uses Sea-Bird Electronics SeaSoft software to convert hexadecimal SeaCat
datainto ASCII conductivity-temperature-depth data, and then converts the ASCII
datainto a depth-binned sound velocity file. Velocwin software is also used to
process Moving Vessel Profiler (MVP) sound velocity datainto a CARIS compatible
format. Velocwin allows for batch processing of the numerous .calc files generated
by the MV P during multibeam echosounder acquisition. The resulting .svp files are
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applied in CARIS HIPS during post-processing to correct for sound velocity variation
within the water column. These sound velocity files are applied to the datain CARIS
HIPS. Velocwin is also used to check the accuracy of sound velocity casts and to
archive sound velocity information for the National Oceanographic Data Center.

A.8 Bottom Sampling Equipment

A.8.1 Bottom Samplers

A.8.1.1 Kahlsico Mud Snapper 214WA100

Manufacturer Kahlsico Mud Snapper

Model 214WA100

Deployed by one person by hand and is best used for shallow-water bottom samples
acquired on the survey launches. It isafoot-trip model, capable of fitting through a
15 cm (6") diameter ice-hole, and fabricated from sturdy bronze and stainless steel
materials to assure long-time, trouble-free service. The Snapper has along threaded
post with a strong compression spring surrounding it which presses against the jaws
at one end and is seated inside a cap at its upper end. By turning the threaded cap,

Description spring-tension adjustment is effected on the closing jaws which are easily cocked
open by the attached foot-trip assembly. The post may be fastened to along, hand-

held rod for shallow-water use, to a sounding weight for intermediate-water sampling
or to alowering line for free-fall to the bed of alake, estuary, reservoir, etc. Upon
impact with the bottom, the foot-trip is pushed up, disengaging the pivoted locking
arm and allowing the spring-tensioned, hinged jaws to snap shut.
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Figure 13: Kahlsico Mud Shapper

A.8.1.2 Ponar Wildco #1728

Manufacturer Ponar Wildco

Model #1728

The Ponar Wildco Model # 1728 sampler may be deployed by one person by
hand and is sometimes used with the DT Marine Oceanographic winch for ship-
based bottom sample acquisition. The Ponar Grab is a self-closing sampler using a
patented spring-loaded Pinch-Pin™ system that rel eases when the sampler impacts
the bottom and the lowering cable or line becomes slack. A Safety-Pin replaces the
Pinch-Pin when sampling to prevent unexpected closing of the scoops and protects
o the operator from injury by sudden closing of the scoops. Self-closing scoops have
Description center pivot closing action. When the scoops contact the bottom, they obtain good
penetration with very little sample disturbance. An underlip, attached to the scoops,
wipes clean most pebbles and small cobble that would prevent the scoops from
closing completely. Removable side plates prevent the lateral loss of sample when
scoops are closing
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Figure 14: Ponar Wildco Model # 1728

B Quality Control

B.1 Data Acquisition

B.1.1 Bathymetry
B.1.1.1 Multibeam Echosounder

During multibeam data collection, watch-standers continuously monitor the Reson acquisition system.

On THOMAS JEFFERSON, MBES data acquisition is controlled via Hypack/Hysweep software.
Thresholds set in Hypack/Hysweep, as well as POSView and the RESON 1/0 Module alert the watch-
stander by displaying alarm messages when error thresholds or tolerances are exceeded. These alarms,
displayed as they occur, are reviewed and acknowledged on a case-by-case basis. Alarm conditions that
may compromise survey data quality are corrected and then noted in acquisition log. Warning messages
such as the temporary loss of differential GPS, loss of external clock data (timing from POS/MV), loss of
sound speed from the surface sound velocimeter, or excessive cross-track error are addressed by the watch-
stander and corrected before further data acquisition occurs.
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Along-track data density is managed by controlling vessel speed-over-ground and sonar ping rate. Vessel
speed during MBES operations can range between 0 and10 kts depending on density requirements and
environmental conditions at the time of acquisition. Vessel speeds during MBES acquisition are nominally
8.5 ktsfor the launches and 9.5 kts for the ship.

Ping rate is usualy set between 14 and 20 pings per second. Asthe range scale increases, the ping rate
achievable by the sonar system decreases. If the ping rate is set significantly higher than the ping rate that
the sonar can achieve, then buffer overflow is possible. Buffer overflow can result in system instability and
can introduce timing latency into the data. Therefore, it isimportant for the sonar operator to monitor the
ping rate frequently during acquisition.

The Reson 7125 SV sonars have the option for roll stabilization. This utilizes active beam steering to
remove the affects of roll-motion during ping transmission. Roll-stabilized systems reduce the likelihood of
holidays between adjacent lines due to inadequate line overlap. It is standard operating procedure to operate
the Reson 7125 SV sonarsin roll-stabilized mode. Roll stabilization is not available for the RESON 7125
ROV system installed on the ship.

Another feature of the Reson 7125 systems (ROV and SV) is an auto-pilot setting. User-configured
parameters such as power, gain, ping rate, absorption, and spreading can be optimized for a particular
survey area and then saved to a configuration file. When beginning survey operations in a new survey area,
it is standard practice to create one or more configuration files that properly tune the sonar for the area.
During acquisition, the watch-stander operates the sonar in the "Auto-Pilot" mode and monitors the quality
of the sonar data. If the auto-pilot settings are not performing adequately, the watch-stander must switch
to manual control and either modify the auto-pilot setting and return to auto-pilot control, or continue to
operate the sonar in manual control.

B.1.1.2 Single Beam Echosounder

During vertical beam data collection, watch-standers continuously monitor the Odom acquisition system.
Thresholds set in Hypack and POSView alert the watch-stander by displaying alarm messages when error
thresholds or tolerances are exceeded, and any issues are addressed by the watch-stander and corrected
before further data acquisition occurs.

The Odom Echotrac CV 200 sonar system is controlled via the E-Chart software provided with the system.

E-chart software's standard operating procedure isto configure the VBES sonar such that the primary
channel is configured for 200kHz (high frequency) and the secondary channel is configured for 24 kHz (low
frequency). As part of the standard operating procedure, auto power and auto gain settings are used to tune
the VBES. Occasionally, environmental conditions necessitate manual control of the power or gain.

It isimportant for sonar operators to open araw VBES datafile at the beginning of the survey day and

periodically throughout the day to determine if timing latency issues are present. When timing issues are
observed, acomplete re-start of all acquisition systems often resolves the issue.
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B.1.1.3 Phase M easuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not acquired.
B.1.2 Imagery

B.1.2.1 Side Scan Sonar

During side-scan data collection, watch-standers continuously monitor the Klein acquisition system.
Thresholds set in SonarPro and POSView aert the watch-stander by displaying alarm messages when error
thresholds or tolerances are exceeded, and any issues are addressed by the watch-stander and corrected
before further data acquisition occurs.

Standard operating configurations for the Klein 5000 are: 50 micro-second chirp and 20cm resolution (along
track). Digital datafrom the KLEIN 5000 TPU is sent directly to the acquisition computer for display and
logging by KLEIN SonarPro software. Raw digital side-scan data from the KLEIN 5000 is collected in
(SDF) and maintained at full resolution, with no conversion or down-sampling techniques applied. These
files are archived to the raw data storage drives at the end of each line for initial processing and quality
control review.

The sonar operator monitors the image quality in real-time, looking for signs of refraction that could make
height estimates on features inaccurate. When refraction is encountered there are a few options available.
For towed systems, the cable-out can be adjusted to get the sonar above or below the layer causing the
refraction. It is preferable to get the sonar below the refraction layer if safety and operational conditions
permit. For hull mounted systems, the vessel must rel ocate to an area without refraction, must change the
mode of survey operations (such as Object Detection MBES), or must cease operations until the water
column is more conducive for surveying.

B.1.2.2 Phase M easuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not acquired.

B.1.3 Sound Speed
B.1.3.1 Sound Speed Profiles

A Brooke Ocean Technology Moving Vessel Profiler (MVP) with an Applied Microsystems Smart Sound
Velocity and Pressure (SV & P) sensor or a Seabird Electronics SBE-19 CTD were used to collect sound
speed profile (SSP) datafrom THOMAS JEFFERSON. Seabird Electronics SBE-19 CTD+ units were
used to collect sound speed profile (SSP) data from Launches 3101 and 3102. SSP data were obtained at
intervals frequent enough to reduce sound speed errors. The frequency of casts was based on observed
sound speed changes from previously collected profiles and time elapsed since the previous cast. The
ship acquired casts at 15 — 30 minute intervals while acquiring cross-lines at the beginning of each project
to determine the variability in sound speed in the survey area. Subsequent casts were made based on the
observed trend of sound speed changes. As the sound speed profiles change, cast frequency and location
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are modified accordingly. Confidence checks of the sound speed profile casts are conducted weekly by
comparing simultaneous casts taken with all sound speed determining devices on the ship and each launch.
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Figure 15: MVP Cast

B.1.3.2 Surface Sound Speed

Sound speed uncertainty for THOMAS JEFFERSON is calculated for each project area. Because the intake
for the SSV'S on the ship is not located at the transducer, it is necessary to account for the differencein
sound speed due to the vertical offset of the transducer with respect to the intake, the effects of roll due to
the athwartship offset between the transducer and intake, and the time delay between water entering the
intake and the SSV S unit registering the change.

On DN 203 (2010) atest was designed to measure the latency associated with the AML Smart SV&T
arrangement. The experiment determined that it takes approximately 3 minutes for the SSVSin the sea
chest to register a change in sound speed from the intake. Based on the latency value of approximately 3
minutes and based on the athwartship and vertical offsets between the sea chest intake and the Reson 7125
transducer on the ship, uncertainty values for the speed of sound are calculated for each project. These
uncertainty values are compared to the default value of 0.2m/s, and when deemed significant, are applied
during TPU processing in CARIS Hips and Sips. The calculated values for surface sound speed are derived

from the following equation:

Uncertaintyssv = Square Root of [(#sv/tlatency)] "2 +[(#sv/#z)"2 + ((#sv/(#y)tan#rol )2 ]
Where (#sv/tlatency) is the change in sound speed along-track due to the approximately 3 minute lag
time associate with the plumbing of the SSV S and the sea chest configuration on the ship; (#sv/#z) is

the difference in sound speed due to the static vertical offset between the intake and the transducer as
observed in sound speed profiles of the water column; and ([(#sv/(#y)tan#roall) is the change in sound speed

43



2011 DAPR Version 1.0 NOAA Ship Thomas Jefferson

attributable to roll of the ship with regard to the athwartship offset when compared to sound speed profiles
of the water column.

TPU Parameters for sound speed uncertainties are documented in each survey’s Descriptive Report.

B.1.4 Horizontal and Vertical Control
B.1.4.1 Horizontal Control

The Horizontal Datum for survey operations is the North American Datum of 1983 (NAD83). 2011 surveys
were either in UTM zone 18 (OPR-E350-TJ-11 and OPR-D304-TJ-11) or UTM Zone 19 (OPR-B363-TJ-11
and S-A916-TJ-11). Horizontal control for survey operationsis primarily derived from Differentially-
corrected GPS, using USCG differential correctors. Differential beacons are chosen based on their proximity
to the survey grounds and the signal-to-noise ratio of the beacons if more than one beacon is near the survey
grounds. For surveysin the vicinity of Norfolk, the Driver, VA beacon is the primary beacon. The beacon
at New Bern, NC was used during temporary outages at the Driver, VA site. For surveysin the Block Island
Sound (BIS) area, the beacons at Moriches and Acushnet were used.

Other tools are available for horizontal control, namely Smooth Best Estimate Trajectory (SBET) files
processed from Applanix POSPac files. POSPac files are acquired daily on each vessel during normal
survey operations. These POSPac files provide for a post-processed heave solution called TrueHeave.
Further processing of the POSPac file using Applanix POS MMS 5.4 creates an SBET file which can be
used for both horizontal and vertical control. From the perspective of data acquisition there are few changes
necessary to acquire a POSPac file that will be used to create an SBET as opposed to a POSPac file that will
be used for TrueHeave only. In order to acquire a POSPac file for use in creating an SBET file, the watch-

stander must monitor the number of satellites and PDOP. If the number of satellites, or space vehicles
(SVs) drops below 5, or the PDOP increases above 6, then acquisition should be stopped until SV geometry
improves and the numbers return to acceptable values.

No additional horizontal control methods or tools were used during the 2011 field season.

B.1.4.2 Vertical Control

Vertical Datum for surveysis Mean Lower Low Water (MLLW). For each project, the project instructions
include the method(s) approved for vertical control. Typically, vertical control isbased on one or more
NWLON stations operated by CO-OPS. Co-range and co-phase measurements from the NWLON stations
are used to derive discrete tide zones for a project areain the form of a zone definition file (*.zdf).
Sometimes, it is necessary to install temporary, tertiary tide stations to supplement data from existing
NWLON stations in order to adequately model tides.

Tidal Constituents and Residuals Interpolator (TCARI) is an alternative to discrete zoning. TCARI usesthe
shoreline to generate a Triangulated Irregular Network (TIN) surface that encompasses the survey area.

44



2011 DAPR Version 1.0 NOAA Ship Thomas Jefferson

Water levels and residuals from tide stations in the area are used to popul ate each cell in the TIN, resulting
in a smoother tide solution than can be achieved by discrete zoning.

Both discrete zoning and TCARI are based on the MLLW tidal datum. Observed tides are downloaded from
the CO-OPS website, www.tidesandcurrents.noaa.gov on a daily basis via an in-house software program
called FetchTides. Once CO-OPS have verified the observed data from atide station and corrected any
fliersin the data, a verified tide file for each tide station is made available for download.

An aternative to discrete zoning and TCARI, is Ellipsoid-Referenced Surveying (ERS). ERS utilizesa
completely different approach to vertical control. ERS surveys utilize inertially-aided, post-processed
kinematic (IAPPK) GPS solutions and reference the Ellipsoid as the vertical datum. DGPS measurements
recorded by arover aboard the survey vessel are post-processed with ephemeris correctors and clock
correctors from Continuously Operating Reference Stations (CORS). ERS vertical control datais acquired
in the form of a POSPac file in the same manner as discussed in the previous section on horizontal control.
Processing of ERS data will be discussed further in the data processing section of vertical control.

B.1.5 Feature Verification

Features may be verified by utilizing a variety of tools based on the type of feature and its disposition with
respect to MLLW:

Bearing features that are already depicted on the chart may be verified using various sources of aerial
imagery, whether included in the project instructions or viewed online with GoogleEarth. When feasible,
NGS may fly tide-coordinated ortho-imagery to update the national shoreline. These data sets are included
in the project instructions when available. 1n 2011, a horizontal scanning laser was used to identify bearing
features during H12282, but this technology has not been adopted as standard operating procedure.

Submerged features are investigated with side-scan sonar, multibeam, or both. When investigating a feature
with side-scan, the vessel is positioned to acquire lines adjacent to the feature at a distance approximately
30%-70% of the range scale in use, in order to get the highest quality imagery. At timesit may be necessary
to acquire imagery from multiple directions to obtain sufficient detail to identify the feature. When
investigating a feature with multibeam, the vessel is positioned directly above the feature or as near to
directly above the feature as safety permits. In accordance with the 2011 HSSD - 6.3.2, least depths on
features must be selected from beams within 30° of nadir unless multiple passes are made over the feature.

While not a common technique aboard THOMAS JEFFERSON, DGPS "backpack™ positioning isalso an
approved method for verifying features. A backpack rover unit is positioned over the feature and the site is
occupied for aduration of time which can range from aslittle as 15 seconds to as long as 4 hrs depending on
the required positional accuracy.

Detached Positions (DPs) and Lines of Position (LOPs) are yet another method which may be utilized to

verify the position of features. For DPs, the survey vessel is positioned against or adjacent to the feature
and atarget is created in Hypack using the F5 key. Distance and azimuth from the vessel's reference point
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(RP) are recorded in the target file so the position can be properly corrected in post processing. A variation
of using DPsto verify feature position isthe LOP. With LOPs, multiple DPs (with azimuth recorded) are
acquired from various angles around the feature. When the position and azimuth for each DP are plotted,
the lines intersect at the position of the feature, similar to the way mariners take visual fixes on navigational
aides. The LOP approach is particularly useful in positioning features ashore or inshore where water depth
limits access by the survey vessal.

When feasible, digital images and notes are taken for each feature verified. These images and notes aid in
feature attribution when the feature report is created.

B.1.6 Bottom Sampling

Recommended bottom sample locations are supplied to the field by HSD OPS. These recommended bottom
sample sites are compared to the charted density and current survey datato optimize the final density and
locations for bottom samples sites. Once locations have been determined, atarget file isloaded into the
survey acquisition software. The vessel (ship or launch) is positioned directly above or up current/wind of
the target to facilitate sampling over the proper location.

B.1.7 Backscatter

THOMAS JEFFERSON and launches 3101 and 3102 acquire MBES Snippet Backscatter data with their
RESON 7125 and 7125-SV systems when project instructions specify this type of data as a requirement.
During acquisition, the power is set to maximum power (220 dB). Range Scale and Gain are adjusted as
necessary during acquisition to keep the sonar tuned properly and to prevent intensity value saturation.
Settings such as Absorption and Spreading are adjusted prior to the beginning of acquisition and are not
changed. RESON Autopilot is configured to manage the various settings during acquisition. RESON
systems are configured to send snippet data to the acquisition computer during all MBES operations.

HYPACK/HY SWEEP is the software used to acquire MBES and Snippet Backscatter data on the
acquisition computer. HY SWEEP logs datato HSX format, and when configured to log Snippet
Backscatter data, |ogs data to an additional format called ".7k". The .7k files contain the intensity values
from the Snippet Backscatter data. The HY SWEEP Hardware initialization file can be modified to acquire
Snippets at different sampling rates. Standard operating procedure for THOMAS JEFFERSON isto log
Datagram Version 1 at 25 snippet samples per beam.

B.1.8 Other

No additional data were acquired.
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B.2 Data Processing

B.2.1 Bathymetry
B.2.1.1 Multibeam Echosounder

Raw bathymetry data, (Simrad .all, Hypack .raw and .hsx) are converted into CARIS HDCS data format
upon completion of daily acquisition. Conversion parameters vary for each data format, and are stored in the
Log File of each HDCS processed line folder. After data conversion, attitude and navigation are reviewed
for outliers, and true heave, water level, and sound velocity are applied. Bathymetry lines are then merged.
Following merge, Total Propagated Uncertainty (TPU) is calculated for each sounding. For a more detailed
explanation of TPU calculation of multibeam and vertical beam echo sounder data, refer to Section 4.2.3.8
of the 2011 NOAA Field Procedures Manual.

MBES bathymetry are processed using Combined Uncertainty Bathymetric Estimator (CUBE) surfaces with
resolution determined by the depth range and coverage type in accordance with Section 5.2.2 of the 2011
NOS Hydrographic Survey Specifications and Deliverables (HSSD). CUBE surfaces are described in detall
in Section 4.2.1.1.1 of the 2011 NOS Field Procedures Manual and the CARIS HIPS/SIPS Users Manual.

Once surfaces have been created, data are cleaned of fliers and least depths on submerged features are
designated. A child layer for "IHOnNess" is then created to demonstrate where the survey meets the assigned
IHO Order. Areasthat do not meet the assigned IHO Order are further investigated and resolved.

Once the surfaces are cleaned appropriately, and least depths have been designated on all significant
features, the CUBE surface is "Finalized". When a surface isfinalized, the surface isforced up to honor the
designated soundings over survey features. Also, the uncertainty for each node in the grid is re-assigned
based on the "greater of the two" between the node values for Standard Deviation and Uncertainty.
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Figure 16: MBES Data Processing Flow Chart

B.2.1.2 Single Beam Echosounder

Raw vertical beam datais converted into CARIS HDCS data format upon completion of daily acquisition.

Conversion parameters are stored in the Log File of each HDCS processed line folder. After data
conversion, VBES data are cleaned for fliers using the .bin file to aide in data cleaning decisions. After
the data has been cleaned, attitude and navigation are reviewed for outliers, and true heave, water level,
and sound velocity are applied. Vertical beam lines are then merged. Following merge, Total Propagated
Uncertainty (TPU) is calculated for each sounding. For a more detailed explanation of TPU calculation
of multibeam and vertical beam echo sounder data, refer to Section 4.2.3.8 of the 2011 NOAA Field

Procedures Manuals. The vertical beam lines are then gridded as an Uncertainty BASE surface, typicaly at
4m resol ution.
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Figure 17: Sngle Beam Processing Wor kflow

B.2.1.3 Phase M easuring Bathymetric Sonar

Phase measuring bathymetric sonar bathymetry was not processed.

B.2.1.4 Specific Data Processing M ethods

B.2.1.4.1 Methods Used to Maintain Data I ntegrity

Please refer to the Quality Management section.

B.2.1.4.2 Methods Used to Generate Bathymetric Grids

When the primary source of bathymetry for a survey areais a combination of VBES with MBES
devel opments over features, a collection of finalized uncertainty-weighted mean bathymetric surfacesis
generated as the product of the survey. CUBE is not permitted for set line spacing VBES mainscheme.
When the primary source of bathymetry for thistype of survey is set line spacing MBES data (also known
as “skunk-stripe”), CUBE shall be used. The use of CUBE in this situation is required to guarantee proper
nodal propagation distances as described in section 5.2.1, Gridded Data Specifications, of the 2011 HSSD.
HSSD requires that 95% of the nodesin a CUBE grid contain a minimum of 5 soundings/node.
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When Complete or Object Detection (OD) MB is the primary source of bathymetry, data are processed using
CUBE grids. The use of CUBE is mandatory to ensure compliance with the specification described in the
paragraph above.

Each resolution has its own CUBE parameter settings, and the hydrographer uses the appropriate resol ution-

based CUBE parameters settings when computing each grid. CUBE parameters were distributed with the
project instructions for each survey.

B.2.1.4.3 Methods Used to Derive Final Depths

Cleaning Filters
Methods Used Gridding Parameters
Surface Computation Algorithms

There are anumber of methods available to assist in deriving final depths. The
following sections detail each method. Cleaning filters are tools that are available to
address systematic errors in bathymetry data. Cleaning filters are seldom used aboard
THOMAS JEFFERSON and are not part of the standard operating procedures.
Cleaning filters are most often used to clean bad data resulting from refraction issues
or from poor beam-forming caused by a bad element. While there are a number of
options available when setting filters, filtering by beam number and by beam angle
are the options most commonly used. Final survey depths are taken from statistical
surfaces. These surfaces are created using the Combined Uncertainty Bathymetry
Estimator (CUBE) algorithm or the CARIS Bathymetry and Associated Statistical
Description Error (BASE) algorithm. CUBE was developed by Brian Calder at the University

of New Hampshire (UNH), Joint Hydrographic Center (JHC), Center for Coast and
Ocean Mapping (CCOM). NOAA has devel oped standardized CUBE parameters.
These parameters are distributed to the field units and have been used exclusively for
the creation of all CUBE surfaces during the 2011 field season. CUBE parameters are
chosen based on the type of survey. For object detection multibeam, the IHO Order
laoption is used. For general bathymetry, the IHO Order 1b option is used. Grid
resolution isin accordance with NOS HSSD unless specifically noted otherwise in
asurvey's descriptive report. BASE surfaces are uncertainty-weighted grids and are
primarily used aboard THOMAS JEFFERSON for griding vertical beam data where
the data density is insufficient for the CUBE agorithm.

B.2.2 Imagery
B.2.2.1 Side Scan Sonar

Side-scan sonar data are converted from *.sdf (SonarPro raw format) to CARIS HDCS. Processing side-scan
data includes examining and editing fish height, vessel heading (gyro), and vessel navigation records. When
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side-scan sonar istowed, fish navigation is recalculated using CARIS SIPS. Tow point offsets (C-frame and
cable-out), fish depth, fish attitude, and water depth are used to calculate horizontal layback.

After towfish navigation is recalcul ated, side-scan imagery data are slant-range corrected to 0.1m and beam
pattern correction is applied. The slant-range corrected side-scan imagery data are closely examined for
significant contacts. Points-of-interest are evaluated as potential contacts based upon apparent shadow
height and appearance. Contacts are selected and saved to a contact file located in each line of SSS data
Contact selection includes measuring apparent height and width, selecting contact position, entering notes,
and creating a contact image.

Side-scan sonar coverage is determined by creating mosaics using Mosaic Editor in CARIS SIPS. Mosaic
Editor uses the accurately modeled backscatter correction algorithms of the Geocoder engine to process
source data. This processed imagery datais stored in SIPS as Georeferenced Backscatter Rasters, or
GeoBaRs. GeoBaRs are the basis for all mosaics created in SIPS. From the GeoBaRs, mosaics are created
which can be examined and edited in Mosaic Editor. Once imagery has been corrected, afull mosaicis
created for each 100% coverage.

Create Project
In CARIS Slant Range Correct

Select Appropiate

Vessel File Beam Pattern Correct

Convert Raw Data

Using CARIS Conversion Create GeoBaR

Review Attitude Data Creste Mossie

Review Navigation Data Review SSS Lines
Recompute Towfish
Nazigation Select Significant Contacts

Figure 18: Sde-Scan Imagery Processing Diagram

B.2.2.2 Phase M easuring Bathymetric Sonar

Phase measuring bathymetric sonar imagery was not processed.

B.2.2.3 Specific Data Processing M ethods
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B.2.2.3.1 Methods Used to Maintain Data I ntegrity
Please refer to the Quality Management section.
B.2.2.3.2 Methods Used to Achieve Object Detection and Accuracy Requirements

Object detection from side-scan imagery is obtained by acquiring the entire survey area two times, with
survey lines in the second coverage offset halfway between the lines from the first coverage. Thisresultsin
200% Side-Scan Coverage with line spacing based on 80% of the range scale.

To ensure positional accuracy, a side-scan certification test is performed. Multiple passes are made on
adiscrete feature (1m cube when possible) that ensonifies the feature with each transducer at a distance
approximately 15%, 50%, and 80% of the range scalein use. A total of 12 passes are made and the feature
must be detected in at least 10 of the 12 pass. All survey lines are then processed and a contact created for
the feature. Contact positions are plotted and compared to the actual position of the feature. The contacts
must be within 5m of the actual position for hull-mounted systems and 10m for towed systems.

B.2.2.3.3 Methods Used to Verify Swath Coverage

Side-scan sonar coverage is determined by creating mosaics using Mosaic Editor in CARIS SIPS.  Each
100% of coverage is evaluated independently for gapsin coverage. Any holidays noted in the mosaics must
be re-acquired in amanner that will ensonify the area from the same incidence angle as originally intended.

B.2.2.3.4 Criteria Used for Contact Selection

For water depths less than 20m, contact heights of 1m or greater are considered significant. For water depths
20m or greater, contact heights of 10% of the water depth are considered significant. A feature is created
for each significant contact.

B.2.2.3.5 Compression Methods Used for Reviewing I magery

No compression methods were used for reviewing imagery.

B.2.3 Sound Speed
B.2.3.1 Sound Speed Profiles

Sound speed profiles are acquired by two types of devices: CTD and MVP. Sound speed casts from aCTD
are downloaded to a computer designated to process sound speed casts. On the launches, the acquisition
computers are used, on the ship, a processing computer in survey isused. Sound speed casts acquired using
the MV P are processed on the acquisition computer that controlsthe MVP. In each case, the sound speed
profiles are processed using Velocipy. Velocipy isan in-house software application written in the Python
programming language and distributed with the in-house program Pydro.
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Once a cast has been downloaded, the position of the cast and other metadata are entered. Next, the SV
tab isreviewed and the watch-stander must determineiif it is necessary to extend the cast based on the
trend of the SV profile near the bottom. In most cases, it is unnecessary to extend a cast because Caris
automatically usesthe last valuein a SV profile for al depths beyond the last profile value. However, if

there isa significant change in the SV profile near the last data point in the cast, then it may be necessary to
extend the cast using the most probable slope option.

Profiles are then exported to concatenated Caris SVP files.

B.2.3.1.1 Specific Data Processing M ethods

B.2.3.1.1.1 Caris SVP File Concatenation Methods

SV P files are concatenated by day to create an SVP day file for each vessel. The SVP text filesfor each
vessel day are then manually concatenated into Master SV P files for each vessel per survey.

CTD/MVP data
acquired

Cast data
downloaded

Cast loaded into

SV Cast Reviewed
for Completeness

Additional
metadata entered

Lat/Lon position

Decision made on
whether or not to
extend cast

SV cast exported
to Concatenated
CARIS SVP File

Review CARIS SVP

file - Verify proper
concatonatiion

Velocipy of cast entered

Figure 19: SVP Processing Diagram

B.2.3.2 Surface Sound Speed

Unlike CTD profilers, surface sound velocity sensors (SSV'S) calculate sound velocity (sound speed) in
water using the measured two-way travel time. Thetypical SSV'S consists of atransducer and a reflector
at aknown distance from the transducer. A pulse of known frequency is emitted, reflects at the reflector
surface, and returns. The two-way travel time is measured, and sound velocity is derived (distance divided
by time). SSVS are required for flat faced multibeam systems and systems that perform active beam

steering at the transducer head. The RESON 7125 ROV and RESON 7125-SV systems both require SSVS
data, as does the Klein HydroChart 5000.
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Surface sound velocity (speed) isinput directly into the RESON 7125 Transceiver Processing Unit (TPU).

The RESON [/0O modul e receives the message string and saves it to the raw data being logged. A surface
sound speed value is recorded along with each ping and is used to correct for the launch and receive angles
as the sound wave passes between the ceramics of the transducer and the water, allowing for proper ray-
tracing during processing.

Sound Speed Beam T RESON 1/O CARIS
message b 8 Module writes Conversion and
5 ased on the :
received by Aberd the Sound processing uses
1/0 Module of Speed to the SSVS data in the
surface sound . s
the RESON cried raw sonar file in ray-tracing
TPU P real-time algorithm

Sound Speed

Determined by
SSVs

Figure 20: Surface Sound Velocity (Speed) Processing

B.2.4 Horizontal and Vertical Control
B.2.4.1 Horizontal Control

Horizontal control data comesin the form of a POSPac file, or in the case of GPS base stations, from the
RINEX file. During 2011, the field unit did not use a GPS Base Station, so the procedures to process base
station datais not discussed in this report.

POSPac files were processed into Smoothed Best Estimate Trajectory files using Applanix POS MMS

5.4. All datawere processed in the ITRF2000 reference system until the SBET is exported as a Custom
Smoothed BET in NAD83. To process a POSPac file, it must first be loaded into POSMMS5.4. This

is done by dragging and dropping the .000 POSPac file into the Plan View window. Next, base stations
are selected, and clock and ephemeris data are downloaded and the raw dataisimported. Next, the datais
QC'ed by running the Smart Base Quality Check feature. If thereisaproblem with the data quality, then a
different control station may need to be chosen, one of the other base stations may need to be disabled, and/
or datafrom another station may be necessary. Once any data quality problems are resolved, the Applanix
SmartBase processor is used to create the SmartBase region. Next, the GNSS-Inertial Processor is used

to create the SBET. Applanix Infusion SmartBase is used to process SBET files unless specifically noted

54



2011 DAPR Version 1.0 NOAA Ship Thomas Jefferson

otherwise in asurvey's descriptive report. Once the SBET has been created, the message log is reviewed
for quality control. Finally, the SBET is exported to a Custom SBET in the NAD83 datum with UTM
projection.

PDOP should be less than 6 for the entire SBET file or there will be high RMS-Error values. Additionally,
the number of space vehiclesisrequired to be 5 or more.

Smart Base Quality Check
Processor

SAET Aol Contol Export Custom Smoothed
Review Message Logs and ped  BET to NAD83 and UTM

Display Plots reference

NAVDIF to compare the
Real-time navigation data
to the Custom Smoothed

BET solution

Figure 21: Sepsto create a Smoothed Best Estimate Trajectory (SBET)

B.2.4.2 Vertical Control

Vertical control is achieved viatide measurements or via processed SBET files. Tide station datais
processed by CO-OPS and is available for download using the FetchTides application developed by HSTP.
No field processing of tide station data occurs. Vertical control from SBET filesis processed as discussed
in the horizontal control section above. Vertical datafor al surveysis Mean Lower Low Water (MLLW)
unless specifically stated otherwise a survey's descriptive report.
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During Caris
Processing i Select the appropriate Import Navigation Data at

Load Attitude/Navigation SBET.out file(s) 0.1seconds

Data

For Vertical Control, Re-examine navigation data
Emd additionally ImportGPS Bl and clean spikesin dataas
height at 0.02 seconds necessary

Import Gyro, Pitch, and Roll
Data at 0.02 seconds

Load Error Data Select Sounding Datum

Ellipsoid or MLLW via
Vdatum Seperation Model

‘) —

Figure 22: CARIS processing utilizing SBET files for Horizontal and Vertical Control

For Vertical Control Only
Compute GPS Tide

B.2.5 Feature Verification

Least depths of navigationally significant features are flagged as “ designated soundings,” which both
identifies the object as a navigationally significant object for import into Pydro and forces the depth of the
grid to match the least depth of the feature.

Following data cleaning in CARIS HIPS, designated soundings and side-scan contacts are inserted into
aPYDRO Preliminary Smooth Sheet (PSS). DP and GP features are inserted using the “ Generic Data
Parser” tool. Images of contacts exported from CARIS are displayed in the Image Notebook Editor in
PYDRO. Contacts are arranged by day and line and can be selected in the data “ Tree” window. Information
concerning a specific contact is reviewed in the Editor Notebook Window in PY DRO. Thisinformation
includes contact positions, AWOIS item positions, contact cross references, and charting recommendations.

Contacts are classified according to type of contact (e.g. MBES, SSS, DP, etc), confidence, and proximity
to other contacts. Although thiswill vary from survey to survey, the following general rules apply for
classification of contacts:

* MBES contacts will be classified as primary contacts over SSS, DP, and GP contacts;

* If there are two or more MBES contacts for the same feature, the MBES contact of |east depth is classified
asthe primary contact;

* If there is no bathymetry contact for a feature, then the SSS position will be classified as primary contact
over DP and GP contacts,
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* If there are two or more SSS contacts for the same feature, then the SSS contact that best represents the
feature is classified as the primary contact;

« If there are no bathymetry or imagery contacts, then the DP contact that best represents the featureis
classified as the primary contact.

Multiple representations of one distinct feature (e.g. contacts from two or more SSS lines on a known wreck)
may be grouped. For agroup of features, one representation is selected as the primary contact, and al others
are selected as secondary contacts with respect to the primary contact.

Significant features are defined by the Hydrographic Survey Specifications and Deliverables as an object
rising more than 1m above the seafloor in water depths of 0-20m, and an object rising 10% of depth above
the seafloor in water depths greater than 20m. Either echosounder |least depth or side-scan sonar acoustic
shadow height may be used to determine height of an object off the water bottom.

Contacts appearing significant are further investigated with a MBES system capable of meeting NOAA
object detection specifications. If there is no known least depth of good confidence on a significant feature,
then the feature will be flagged as “Investigate”. Features with such atag must be further developed, in
order of preference, with multibeam echosounder, diver least depth gauge, or vertical beam echosounder.

Any items that are to be addressed in the Feature Report (Appendix 11) of the Descriptive Report are flagged
as “Report”. Examples of Report items include positions of new or repositioned Aids to Navigation,
permanent man-made features which do not pose a danger to surface navigation, or dynamic sedimentary
bed forms.

BeV|ew of _Shurell_ne Gl Teatuers by Strvey Create an Assigned |dentify baring features
files submitted with Bound e Emmed FeaturesFile (AFF) for B that can be addressed
Project Instructions each survey during low tide recon

Full 5-57 attribution of e e
assigned baring v dsEin Review 5SS data for
f features in the Final §i 555 /Mv BES/VBES significant contacts
Features File (FFF)
Contacts and Itel.ns req.u : r||.1g e MBES investigations
Bathymetry loaded into P mvestdlgatlan are f M acquire object detection Bathymetry data loaded
Pydro for review and I\:"‘g?\:’lt'? o Mapl o bathymetry over into Pydro
correlation i Mor000 soline significant contacts
plans can be created

Feature correlation with S-57 Attributesfilled out Baring features and Adobe PDF Feature

Bathymetry as primary for all features to be submerged features Reports created and
and AWOIS and sidescan combined into a single il included in Appendix Il of
as secondary features file (FFF) Final Features File (FFF) the Descriptive Report

Figure 23: Features Management Wor kflow
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B.2.6 Backscatter

Once data has been acquired, the MBES Snippet Backscatter datais processed in three major steps. First,
the .HSX multibeam datais processed as normal in CARIS HIPS. Once the data has been processed
through the TPU step, each .HSX line can be exported to .GSF format using CARIS HIPS Export Wizard.

The second step isto convert the HY PACK .7k files into the RESON .s7k format. Thisis accomplished
by running a Python script from NOAA's in-house Feature Management software PY DRO. The script
7k2s7k.exe does exactly what its name suggests, it converts the header file for each line from the .7k format
of HY PACK\HY SWEEP into the .s7k format native to RESON. Thefinal step utilizes IVS Fledermaus
FMGT. Thistool is1VS'simplementation of the Geocoder processing tool originally developed at the
University of New Hampshire, Joint Hydrographic Center, Center for Coastal and Ocean Mapping (UNH,

JHC-CCOM). Fledermaus utilizes the .GSF files to extract the navigation information for each survey line
and the backscatter intensity data from the .s7k files to generate a processed backscatter mosaic.

Backscatter processing in the field is primarily for quality assurance only. Raw Snippet Backscatter datais
the only field deliverable.

Backscatter file from
Bathymetry data from Caris HDCS data exported to Hypack/Hysweep (.7k) is
Hypack/Hysweep (.HSX) e GSF format as the source for Smd  converted to .s7k using an
processed normally in Caris navigation data in-house Python script ran as
a Pydro Macro

IVS Fledermaus FMGT
application used to generate
backscatter mosaics per line

Beam pattern file

B s Beam pattern file used to

normalize the mosaic

from GSF and .s7k files truthed data

Final mosaic resolution
determined by overall file
size —must be less then 1GB
with WinXP

Figure 24: MBES Backscatter Processing Wor kflow

B.2.7 Other

No additional data were processed.

B.3 Quality Management
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A systematic approach to Quality Management has been instituted aboard the THOMAS JEFFERSON,
starting well before the field season begins, through to the final packaging of Survey Deliverables and
delivery to AHB.

Clear and concise communication is critical at all stages of the survey, and is established between all relevant
parties at the earliest stage of the process. Figure 1 represents the partiesinvolved at all stages of the
Quality Management process.

In the Review Project Requirements stage, the final project instructions are reviewed for specific criteria.
Some of these are:

* Isthe Survey fit for the Purpose?

* Areal charted features and AWOIS in the Composite Source File (CSF)?

* Are there any extraneous or unassigned featuresin CSF?

* Isthe Survey areasonable size (2 weeks)?

* Does the work assigned fit within allowed time period?

* Are the resources available for the job?

» Do we have the right equipment, spares, qualified staff, OT, software and specs?

* Are there any special requirements from HSD OPS?

If any of these elements are found to be in question, dialog is opened with HSD OPS, in order to resolve
them. Once these questions have been answered, the Acquisition manager can prepare the survey plan. This
would include the following requirements:

* Line plans/Polygons, Crossline plans, Bottom Sample plan

* Feature requirements as addressed in the Composite Source File (CSF) or ENC.

* Safety of Operations, i.e. where we can and cannot go.

* The plan’s effectiveness and efficiency.

* Proper or maximum platform utilization.

* Survey Specific Sensor configurations, staffing plans, line plans, target files, etc.

All aspects of the survey plan are carefully reviewed by the CST, FOO and CO for any required changes
initiated by the Acquisition manager before survey begins.

A weekly progress review of all planned and open surveysis conducted to evaluate and incorporate the
following factors into the acquisition and deliverables schedule:

* Ship schedule (imports/transits)

» Completion rate, estimated survey end date

» Weather factors

* Equipment failures

* Processing backlog (if any)

The goal isto continuously manage multiple surveys and to establish a projected survey shipment date which
accurately reflects all known factors. If processing is not keeping pace with acquisition, then additional
resources can be deployed to reduce backlogs. Thisin turn allows for better quality assessment of collected
data.

A Progress review of the survey occurs shortly before completion, with the following goals:

* Review remaining work
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* Evaluate density coverage (5 Pings per grid node?)

* Confirm that all assigned features have coverage

* Prioritize remaining work for time remaining

* Adjust personnel and platform schedules as necessary

* Evaluate grids for systematic errors (Std Dev, Uncertainty)
* Review initial field sheet layout

After acquisition is complete and the Deliverables manager has applied final tidesto al data, a Content
Review is performed on the initial results of the survey, primarily surfaces and feature reports. Some of the
particular items addressed are:

» Systematic errors evident in the child layers of the grids (Density, Std Dev, Hypothesis Count) that need to
be addressed in the DR.

* Review feature report and advise changes or revisions.

 Consider any feature candidates for DtoN'’s.

» Determine any unusual acquisition or processing issues that need to be discussed in DR.

The final stage of the Quality Management system is a multiple review of the deliverables, by the CST,
FOO and CO, each ensuring that all Specs have been met and that any revisions or changes identified in the
Content Review have been made. These checksinclude:

» Examine finalized/thresholded grids for flyers or unresolved systematic issues. Are they discussed in the
DR?

* Final check of feature report inclusions, relevance, S-57 attribution, image quality and general
compl eteness.

* Vetting of the final DR. Does it reflect the Content Review discussion?

» Housekeeping — are all the ancillary reports, documents and data included and in the proper place?

Acquisition
Manager

Deliverables
Manager

ST

Figure 25: Quality Management Loop
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Figure 26: Quality Review Stages

B.4 Uncertainty and Error Management

This section still needs to be filled.

B.4.1 Total Propagated Uncertainty (TPU)
B.4.1.1 TPU Calculation Methods

TPU is calculated by CARIS HIPS during the TPU step in processing. CARIS uses aroot sum squared
method to calculate the vertical uncertainty of each node in a statistical surface.

B.4.1.2 Source of TPU Values

The majority of values entered into each vessel's HVF come from published values from the sensor
manufacturer. X,Y,Z offset uncertainties are based on the conditions during the NGS offset measurements
for each vessel. Other uncertainly values are derived from observations by the field unit during survey
operations. Each vessel's CARIS HIPS/SIPS HVF TPU values and user defined uncertainty parameters are
applied during the TPU step in processing.

B.4.1.3 TPU Values
Vessel S222
Echosounder Reson 7125 400 kilohertz
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Gyro 0.02 degrees
5% Amplitude
Heave
Motion 0.05 meters
Pitch 0.05 degrees
Roll 0.05 degrees
Nav_| gatl on 0.8 meters
Position
Transducer 0.005 seconds
Navigation 0.005 seconds
o Gyro 0.005 seconds
Timing
Heave 0.005 seconds
TPU Sandard Pitch 0.005 seconds
Deviation Values Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
z 0.05 meters
Gyro 0.1 degrees
MRU Alignment || Pitch 0.1 degrees
Roall 0.1 degrees
Foeed 0.53 meters/second
Loading 0.05 meters
Vessel
Draft 0.1 meters
Delta Draft 0.05 meters
Vessel 3101
Echosounder Reson 7125-SV 400 kilohertz
Gyro 0.02 degrees
5% Amplitude
Moti Heave 0.5 met
otion .5 meters
TPU Sandard
Deviation Values Pitch 0.02 degrees
Roll 0.02 degrees
Nav_l gatl on 0.8 meters
Position
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Transducer 0.005 seconds
Navigation 0.005 seconds
Timing Gyro 0.005 seconds
Heave 0.005 seconds
Pitch 0.005 seconds
Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
0.05 meters
Gyro 0.1 degrees
MRU Alignment || Pitch 0.1 degrees
Roall 0.1 degrees
Soeed 0.53 meters/second
Vessd Loading 0.02 meters
Draft 0.02 meters
Delta Draft 0.02 meters
Vessel 3101
Echosounder Reson 7125 200 kilohertz
Gyro 0.02 degrees
5 % Amplitude
Motion Heave 0.05 meters
Pitch 0.02 degrees
Roll 0.02 degrees
Es;iggg on 0.800 meters
TPU Sandard Transducer 0.005 seconds
Deviation Values Navigation 0.005 seconds
Timing Gyro 0.005 seconds
Heave 0.005 seconds
Pitch 0.005 seconds
Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
z 0.05 meters

63




2011 DAPR Version 1.0 NOAA Ship Thomas Jefferson
Gyro 0.100 degrees
MRU Alignment || Pitch 0.100 degrees
Roall 0.100 degrees
Soeed 0.530 meters/second
Vsl Loading 0.020 meters
Draft 0.020 meters
Delta Draft 0.020 meters
Vessel 3101
Echosounder Odom CV 200 200 kilohertz
Gyro 0.02 degrees
5% Amplitude
Motion Heave 0.05 meters
Pitch 0.02 degrees
Roll 0.02 degrees
g'g;it?gg N 08 meters
Transducer 0.005 seconds
Navigation 0.005 seconds
Timing Gyro 0.005 seconds
Heave 0.005 seconds
TPU Standard Pitch 0.005 seconds
Deviation Values Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
z 0.05 meters
Gyro 0 degrees
MRU Alignment || Pitch 0 degrees
Roll 0 degrees
Soeed 0.530 meters/second
Vessed Loading 0.02 meters
Draft 0.02 meters
Delta Draft 0.02 meters
Vessel 3102
Echosounder Reson 7125 400 kilohertz
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Gyro 0.020 degrees
5% Amplitude
Heave
Motion 0.05 meters
Pitch 0.020 degrees
Roll 0.02 degrees
Nav_| gatl on 0.800 meters
Position
Transducer 0.005 seconds
Navigation 0.005 seconds
o Gyro 0.005 seconds
Timing
Heave 0.005 seconds
TPU Sandard Pitch 0.005 seconds
Deviation Values Roll 0.005 seconds
X 0.050 meters
Offsets y 0.050 meters
z 0.050 meters
Gyro 0.100 degrees
MRU Alignment || Pitch 0.100 degrees
Roall 0.100 degrees
Foeed 0.530 meters/second
Loading 0.020 meters
Vessel
Draft 0.020 meters
Delta Draft 0.020 meters
Vessel 3102
Echosounder Reson 7125 200 kilohertz
Gyro 0.020 degrees
5% Amplitude
Moti Heave 0.050 met
otion ) meters
TPU Sandard
Deviation Values Pitch 0.02 degrees
Roll 0.02 degrees
Nav_l gatl on 0.500 meters
Position

65




2011 DAPR Version 1.0 NOAA Ship Thomas Jefferson
Transducer 0.005 seconds
Navigation 0.005 seconds
Timing Gyro 0.005 seconds
Heave 0.005 seconds
Pitch 0.005 seconds
Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
0.05 meters
Gyro 0.100 degrees
MRU Alignment || Pitch 0.100 degrees
Roall 0.100 degrees
Soeed 0.530 meters/second
Vessd Loading 0.02 meters
Draft 0.02 meters
Delta Draft 0.02 miles
Vessel 3102
Echosounder ODOM ETCV200 200 kilohertz
Gyro 0.02 degrees
5 % Amplitude
Motion Heave 0.050 meters
Pitch 0.02 degrees
Roll 0.02 degrees
Es;iggg on 0.500 meters
TPU Sandard Transducer 0.005 seconds
Deviation Values Navigation 0.005 seconds
Timing Gyro 0.005 seconds
Heave 0.005 seconds
Pitch 0.005 seconds
Roll 0.005 seconds
X 0.05 meters
Offsets y 0.05 meters
z 0.05 meters
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Gyro 0 degrees
MRU Alignment || Pitch 0 degrees
Roll 0 degrees
Soeed 0.530 meters/second
Loading 0.020 meters
Vessel
Draft 0.020 meters
Delta Draft 0.020 meters

B.4.2 Deviations
There were no deviations from the requirement to compute total propagated uncertainty.
Additional Discussion

For ERS surveys, thereis currently no dedicated location to enter the VDatum model uncertainty value.

In order to account for VDatum uncertainty in the overall total propagated uncertainty (TPU) for gridded
bathymetry data, the VDatum uncertainty values are entered into the measured tidal uncertainty section of
the "Compute TPU" step that follows Mergein CARISHIPS.  See Figure 27 for atypical example of the
Compute TPU step in MBES processing when surveying to the ellipsoid and using V Datum to reduce to
chart datum (MLLW).

Survey specific parameters

Tide values: Measured 0.10 m Zoning O

Sound Speed values: Measured 1 mfs  Surface g2

|:| Sweep spedfic parameters Uncertainty Source

Peak to Peak Heawve: | 0

() Vessel Settings

Max Roll: | 0

Max Pitch: | 0

Figure 27: Typical TPU values for an ERS survey - note 0.10m
for the Measured Tide value is the VDatum model uncertainty

C Corrections To Echo Soundings
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C.1Vesse Offsetsand L ayback

C.1.1Vessd Offsets
C.1.1.1 Description of Correctors

Vessel offsets have been determined by a NGS survey of sensors and permanently installed benchmarks
throughout the ship. Offsets between GPS antennas, IMU, and various transducers have been installed into
each vessels corresponding CARIS HIPS Vessel File (HVF). Offsets are applied to data during the SVP
and/or Merge steps in processing of bathymetry data, and the Compute Towfish Navigation step in side-scan
processing. Discussion of vessel surveys areincluded in Section A - Survey Vessels.

C.1.1.2 Methods and Procedures
Please refer to Section A - Survey Vessels.

C.1.1.3Vessal Offset Correctors

Vessdl 3101
Echosounder Reson 7125 SV1 400 kilohertz
Date 2010-03-08
X -0.472 meters
y 0.072 meters
z 0.541 meters
MRU to Transducer
X2
y2
2
X 0.201 meters
Offsets
y 0.944 meters
z 4.343 meters
Nav to Transducer
x2
y2
2
Roll 0.000 degrees
Transducer Roll
Roll2
Vessel 3101
Echosounder Odom Echotrac CV 200 200 kilohertz
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Date 2010-03-08
X -1.030 meters
y 0.947 meters
Y4 0.198 meters
MRU to Transducer
X2
y2
2
X 0.239 meters
Offsets
y 1.682 meters
z 3.952 meters
Nav to Transducer
X2
y2
2
Roall 0.000 degrees
Transducer Roll
Roll2 | 0.000 degrees
Vessel 3102
Echosounder Reson 7125 SV1 400 kilohertz
Date 2011-10-03
X -0.522 meters
y -0.033 meters
z 0.545 meters
MRU to Transducer
X2
y2
2
X 0.299 meters
Offsets
y 0.958 meters
z 4.342 meters
Nav to Transducer
X2
y2
2
Roll 0.00 degrees
Transducer Roll
Roll2
Vessel 3102
Echosounder ODOM Echotrac CV-200 200 kilohertz
Date 2011-10-03
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X -1.004 meters
y 0.867 meters
z 0.140 meters
MRU to Transducer
x2
y2
2
-0.035 meters
Offsets
y 1.709 meters
Y4 3.954 meters
Nav to Transducer
X2
y2
2
Roall 0.00 degrees
Transducer Roll
Roll2
Vessel S222
Echosounder Reson 7125 ROV 400 kilohertz
Date 2011-10-03
X 8.499 meters
y -2.364 meters
z 5.062 meters
MRU to Transducer
x2
y2
2
X 7.663 meters
Offsets
y 7.084 meters
z 27.444 meters
Nav to Transducer
x2
y2
Y
Roll 0.00 degrees
Transducer Roll
Roll2

C.1.2 Layback

C.1.2.1 Description of Correctors
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Towfish positioning is provided to CARIS HIPS using cable-out values registered by the Totco cable counter
and recorded in the Sonar Pro SDF files. SonarPro uses Payout and Towfish Depth to compute towfish
positions. The towfish position is calculated from the position of the tow point using the cable-out value
received by SonarPro from the cable payout meter, the towfish pressure depth (sent viaa seria interface
from the KLEIN 5000 TPU to the SonarPro software), and the Course Made Good (CMG) of the vessel.
This method assumes that the cableisin astraight line. Therefore, no catenary algorithm is applied at the
time of acquisition, but in processing, CARIS SIPS applies a 0.9 coefficient to account for the catenary.

C.1.2.2 Methods and Procedures

Layback error is calculated by running a side-scan certification test. Thistest consists of running parallel to
aknown feature at varying ranges from nadir to ensonify the target in the near-field (approx 15% of range
scalein use), mid-field (approx 50 % of range scale in use), and far-field (approx 85% of the range scalein
use). Thetest requiresthat each side of the sonar ensonify the feature at each of these areas in the swath.
Then the test is repeated in a direction that is orthogonal to the original set of lines such that the feature is
ensonified atotal of 12 times. A successful test will detect the feature in at least 10 of the 12 passes. For
hull-mounted systems, the selected contact positions must be within 5m; for towed systems, the contact
positions must be within 10m. Layback error isthe amount of correction that must be applied to minimize
the distance between contact positions.

C.1.2.3 Layback Correctors

Vessel S222
Echosounder Klein 5000 455 kilohertz
Date 2011-03-01
X 6.37 meters
Layback Towpoint y -42.55 meters
-4.80 meters
Layback Error -2.25 meters
Vessel 3101
Echosounder Klein 5000 Light weight 455 kilohertz
Date 2011-03-01
X 0.494 meters
Layback Error 0 meters
Vessel 3102
Echosounder Klein 5000 Light Weight 455 kilohertz
Date 2011-03-01
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X 0.463 meters
Towpoint y -0.02 meters
Layback
-0.852 meters
Layback Error 0.0 meters

C.2 Static and Dynamic Dr aft

C.2.1 Static Dr aft

C.2.1.1 Description of Correctors

Static draft for each vessel is measured viaa sight tube. For the ship, a system of marks have been surveyed
into the ship's reference point. A steel ruler is used to measure from one of these marks and the waterline
height is calculated. A common waterline for the ship when fully loaded with fuel and ballasted normally is
approximately 35cm below the reference point of the ship, but the waterline may change by as much as +/-
30cm over the course of afield season. On the launches, the waterline is measured by placing a steel ruler
directly on the reference mark and measuring directly from the sight tube. The waterline is almost constant
on the launches despite fuel levels or normal loading. The normal range for waterline on each launch is 22.5
cm to 23.5 cm above the reference point.

C.2.1.2 Methods and Procedures

Waterline measurements are recorded daily at the beginning and end of the day on the launches because
the process only takes afew seconds. The process takes considerably longer on the ship, and therefore,
the waterline is measured at least weekly. When feasible, waterline measurements are taken before and
after fueling or ballasting of the ship. The values are kept in a static draft log and periodically updated in
the HVF. Once applied in the HVF, all affected lines have SVP re-applied and are then merged so that the
updated waterline measurements will be applied.

C.2.2 Dynamic Draft
C.2.2.1 Description of Correctors

Dynamic draft during the 2011 field season was determined by the Ellipsoid Referenced Dynamic Draft
Method (ERDDM). This method removes much of the subjectiveness of the traditional dynamic draft
determination methods such observations of alevel rod or sonar reference surfaces. Due to formatting
issues with the XML DAPR, Dynamic draft tables are not included in the main body of the report. The
Dynamic Draft report for each vessel is manually attached to the end of the DAPR document. * Note - 3102
retained dynamic draft values from the 2010 field season. The 2011 ERDDM derived values were not
validated by the field unit early enough in the field season to warrant reprocessing survey data with the
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previous values applied. The difference between the 2011 ERDDM values and the values retained from the
2010 season were less than 3cm across the range of survey speeds.

C.2.2.2 Methods and Procedures

Thefirst step in acquiring ERDDM isto log an Applanix POSPac file through the duration of the step

that follow. Next, the vessel should begin transiting from dead in the water, increasing speed in small
increments and maintaining speed at each speed interval for at least 1 - 2 minutes so the vessel will reach

a hydrodynamic equilibrium at the new speed. Speed should be increased in the manner described until
the vessel has exceeded maximum surveying speed. Next, the vessel should stop remaining DIW for
approximately 5 minutes to provide a clear reference point between the first run and the second run.

After the DIW period is complete, the vessel should repeat the previously described transit in the opposite
direction increasing speed in intervals as before, followed by another period of DIW. ERDDM provides the
most consistent results when performed in an area with no currents or tidal influence. 1f such an areais not
available, then the experiment should be planned for slack water to minimize the difference between speed
over ground (SOG) and speed through the water (STW).

C.2.2.3 Dynamic Draft Correctors

Vessel Dug to formatting issues with the XML DA PR., Dynanic Draft Tables are not included in this
section and have been attached to the end of this report.

Date 2011-03-30

Dynamic Soeed 0.0 meters/second

Draft Table ||Draft 0.0 meters

C.3 System Alignment
C.3.1 Description of Correctors

Patch tests are used for assessing the mounting biases of multibeam sonar systems.

C.3.2 Methods and Procedures

Heave, pitch, roll, yaw, and navigation latency biases for each vessel are corrected during a multibeam bias
calibration test, or "patch test”. MBES vessel offsets, dynamic draft correctors, and system bias values are
contained in HIPS Vessel Files (HVFs). These offsets and biases are applied to the sounding data during
processing in CARIS HIPS. A Patch Test or verification of certain biasesistypically performed at the start
of each field season and re-verified for each project before acquiring MBES data in the new survey area.
Calibration reports are generated for initial calibrations at the beginning of the field season, but reports are
not necessarily generated for each project when values are re-verified. Small changesin theroll bias are
common, but also are not necessarily documented by official reports. Changes in HVFs not accompanied
by full calibration reports are instead documented in the comments column of the HVF entry by the datein
which the change took effect.
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C.3.3 System Alignment Correctors

Vessel TJ S222 RESON7125 STBD.hvf
Echosounder Reson 7125 ROV 400 kilohertz
Date 2011-03-29
Corragion | |0sconds
Pitch 0.3 degrees
Roll 0.18 degrees
Patch Test Values | Yaw -0.05 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
Vessel TJ S222 RESON7125 STBD.hvf
Echosounder Reson 7125 ROV 400 kilohertz
Date 2011-06-01
ST osuons
Pitch 0.30 degrees
Roll -0.02 degrees
Patch Test Values | Yaw -0.05 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
Vessel TJ S222 RESON7125 STBD.hvf
Echosounder Reson 7125 ROV 400 kilohertz
Date 2011-06-03
Corragion | |0sconds
Pitch 0.3 degrees
Roll 0.08 degrees
Patch Test Values || Yaw -0.05 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
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Vessel TJ S222 RESON7125 STBD.hvf
Echosounder Reson 7125 ROV 400 kilohertz
Date 2011-08-20
Coresion | |0sonds
Pitch -0.06 degrees
Roll 0.12 degrees
Patch Test Values Yaw -0.67 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
Vessel TJ 3101 Reson7125 400KHZ.hvf
Echosounder Reson 7125 SV1 400 kilohertz
Date 2011-02-28
Coresion | |0sonds
Pitch 1.567 degrees
Roll -0.418 degrees
Patch Test Values Yaw 1.033 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
Vessel TJ 3101 Reson7125 400KHZ.hvf
Echosounder Reson 7125 SV 1 400 kilohertz
Date 2011-08-20
AT ossons
Pitch 1.28 degrees
Roll -0.46 degrees
Patch Test Values Yaw 1.15 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds
Vessel TJ 3102 Reson7125 400KHZ.hvf
Echosounder Reson 7125 SV 1 400 kilohertz
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Date 2011-02-25
Coregion | 0eoores
Pitch 1.80 degrees
Roll -0.92 degrees
Patch Test Values || Yaw -0.897 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds

Vessel TJ 3102 Reson7125 400KHZ.hvf

Echosounder Reson 7125 SV1 400 kilohertz

Date 2011-08-20
Coregion | 0e0ores
Pitch 0.28 degrees
Roll -0.88 degrees

Patch Test Values || Yaw -1.50 degrees
Pitch Time Correction |0 seconds
Roll Time Correction 0 seconds
Yaw Time Correction 0 seconds
Heave Time Correction |0 seconds

C.4 Positioning and Attitude

C.4.1 Description of Correctors

C.4.2 Methods and Procedures

The THOMAS JEFFERSON uses inertial positioning and orientation sensors and U.S. Coast Guard
Differential GPS (DGPS) for a highly accurate blended position and orientation solution. The 2010 Field
Procedures Manual recommends a horizontal positional uncertainty value in the range of 0.5m —2.0m based
on the quality of differential correctors. Surveys covered by this DAPR were acquired within approximately
50nm of USCG differential beacons. Because of this relatively short distance to the differential beacons,
horizontal positioning errors of 0.5m were used in Caris HVFsfor all platforms during the surveys covered
by thisDAPR. Processing of SBET data during the ERS component of H12180 indicated that a value of
0.7m would have been more appropriate. No changes to the HVF were made after this discovery due to the
additional time that would have been required to reprocess surveys. Since the areas surveyed are relatively
flat with gentle slopes, the underestimation of horizontal position uncertainty has little effect on the overall
uncertainty that would be reported at any given node and does not negate the validity of survey soundings.
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Positioning for data acquired by the launches and the ship are achieved by writing differentially corrected
GPS positions output from the POS/MV to the raw sonar datain real time. Upon conversion in CARIS, the
positional information in the raw sonar datais used to create vessel track lines for the processed data. In
addition, all platforms (except for 1701) have True Heave (along-period recording of vessel heave used to
detect longer period sea swells that may not be detected during short-period heave calculations) applied in
Caris as a post-processed heave solution.

During normal survey operations, no further processing of positional information isrequired. However,
beginning in 2010, OCS has begun adding additional positioning requirements to certain projectsin an
effort to build the internal capabilities necessary to conduct Ellipsoid Referenced Surveys (ERS).

When assigned, the additional positioning requirements involve logging full POSPac data from the POS/
MYV and utilizing POSPac MM S to derive Smoothed Best Estimate Trgjectory (SBET) files. POSPac
MMS requires ephemeris and clock data for the GPS constellation and data downloaded from Continually
Operating Reference Stations (CORS) or other base stations to correct for atmospheric effects in the GPS
data. SBET files are extremely accurate measurements of the 3-D position, speed, and motion of a vessel
and can be used to apply higher quality navigation information to the processed datain Caris. Inertialy
Aided Post Processed Kinematic (IAPPK) navigation may be applied in Caris during the SVP step in the
processing workflow. For OPR-E350-TJ10, H12180, vertical and horizontal positioning was derived from
IAPPK methods. IAPPK methods were not utilized for OPR-K380-TJ-10, OPR -H355-TJ-10 or OPR-
D304-TJ10.

C.5Tidesand Water Levels

C.5.1 Description of Correctors

C.5.2 Methods and Procedures

Discrete tidal zoning is a methodology used by the National Ocean Service (NOS) to provide tide reducers
for hydrographic surveys. Analyses of historical tide data, models, and other research are used to describe
the tidal characteristics of agiven survey area. Co-tidal charts are constructed to define GIS maps of co-
range and co-time lines. The co-tidal maps are used to construct a discrete tidal zoning scheme. Survey
areas are divided up into geographic zones or areas which have defined times of tide and ranges of tide. The
number of zones for a particular survey depends upon the complexity of the tide in the area. Each zone is
described by arangeratio or atime correction to atide station in operation during the survey. Tide reducers
are compiled by applying the appropriate time and range corrections to the observed data relative to Mean
Lower Low Water (MLLW).

Soundings areinitially reduced to Mean Lower-Low Water (MLLW) using preliminary (observed)

water level data. Datamay be obtained from the primary tide gauge through the Center for Operational
Oceanographic Products and Services (CO-OPS) website. Observed water level files are converted to
CARIStidefiles (.tid) and/or text files and applied to all sounding data using either discrete tidal zoning
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in CARIS HIPS or the TCARI module in Pydro. The type of water level correction used in asurvey is
specified in the Water Level Instructions, provided by CO-OPS.

When discrete tidal zoning is specified in the Tide Note, THOMAS JEFFERSON personnel use verified
water levels and final tidal zoning from the Zone Definition File (ZDF) provided by CO-OPS for
hydrographic product generation.

TCARI works by separating the astronomic tide, residual, and datum difference components and treating
them differently. First, the method spatially interpolates each tidal constituent's amplitude and phase
throughout the region, based on data at the water level stations and makes atidal prediction. The amplitude
and phase of constituents at water level stations must have been previously determined by analysis of
historical records. This predicted tide is then added to the residual component, which is computed by
gpatially interpolating the non-tidal values observed at the water level stations at the time of the survey.
Finally, the datum offset, or difference between MSL and MLLW based on historical data, isinterpolated
throughout the region and added to the prediction.

Tidal Constituents and Residuals Interpolator (TCARI) grid files, when applicable, are submitted to
THOMAS JEFFERSON as part of the Project Instruction package. A TCARI grid is computed using the
shoreline, alimiting boundary, and the positions of two or more water level gauges. Harmonic constants,
residual water levels, and gauge weights are interpolated for each grid point, using the data from the water
level gauges as control points. Water level corrections are applied in Pydro using the TCARI tools found
in Pydro 7.3 and beyond. When using TCARI for datum reduction, water level corrections are not applied

to echosounder datain CARIS. Following TCARI water level correction in Pydro, datais merged and
processed.

C.6 Sound Speed

C.6.1 Sound Speed Profiles

C.6.1.1 Description of Correctors

C.6.1.2 Methods and Procedures

CTD Profiles

Sound velocity profiles for the THOMAS JEFFERSON and for Launches 3101 and 3102 are processed using
the program HSTP Velocwin version 8.96 which generates sound velocity profilesfor CARISHIPS. Sound
velocity correctors are applied to MBES and VBES soundings in CARIS HIPS during post processing only.
The speed of sound through water is determined by a minimum of one cast per week (although one per

day is usually acquired) for VBES acquisition and one cast every three to four hours of MBES acquisition,

in accordance with the NOS Hydrographic Surveys Specifications and Deliverables (HSSD). Casts are
conducted more frequently when changing survey areas, or when environmental conditions such as changes
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in weather, tide, current, or significant spatial and/or temporal variation in the speed of sound is observed in
the survey areathat would warrant additional sound velocity profiles. The sound velocity casts are extended
in HSTP Velocwin and applied to all bathymetric datain CARIS HIPS during post processing.

Brooke Ocean MVP

The SV data acquired by the MV P istransmitted to araw SV file folder, where the hydrographer conducts
abasic check of the data for correct day number, sound velocity data, and file format/integrity. The SV cast
may also be graphically viewed and compared with other casts using the Sound Velocity vs. Depth graph in

the MV P controller software. Like CTD casts, MV P casts are processed and/or extended for usein CARIS
HIPS using HSTP Velocwin.

C.6.2 Surface Sound Speed

C.6.2.1 Description of Correctors

C.6.2.2 Methods and Procedures

Sound Velocity

Sound speed data acquired by the surface sound velocity sensors on THOMAS JEFFERSON and Survey
Launch 3101/3102 are recorded in the raw Hypack .hsx files and are used to calculate launch and receive

angles for the ray tracing algorithm. The surface sound velocity sensors are discussed in Section A and will
not be discussed further in this section.
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D. APPROVAL SHEET

This Data Acquisition and Processing Report is respectfully submitted for the following projects:
OPR-E350-TJ-11 Southern Chesapeake Bay, VA

OPR-D304-TJ-11 Approaches to Chesapeake Bay, VA

OPR-B363-TJ-11 Block Island Sound

OPR-S-A916-TJ-11 Boone Island, ME

As Chief of Party, | have ensured that standard field surveying and processing procedures were adhered
to during these projects in accordance with the Hydrographic Surveys Specifications and Deliverables
(2011), Hydrographic Survey Technical Directives HTD 2011-03, and the Field Procedures Manual for
Hydrographic Surveying (2011,).

| acknowledge that all of the information contained in this report is complete and accurate to the best of
my knowledge.

This DAPR applies to all surveys completed in 2011 for the projects listed above.

Approved and Forwarded:

_Michael C. Davidson N K
MUt ot T 2012.03.29 18:26:56 OO ORI SR e
-04'00' B
LT Michael C. Davidson, NOAA CDR Lawrence T. Krepp, NOAA

Operations Officer Commanding Officer
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A.1.2.

3101 Wiring Diagram
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A.1.3. 3102 Wiring Diagram
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A.2. Multibeam Echosounders



A.2.1. S222- DN0O90 7125 Patch Test Results

Multibeam Echosounder Calibration

Field Unit: NOAA Ship Thomas Jefferson
Date of Test: 2011 DN 090
Calibrating Hydrographer(s):

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: Reson 7125 400kHz
System Location: Hull mounted on stdb side

Sonar Serial Number: 61206
Processing Unit Serial Number: 50357
Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: hull mounted on stbd side
Date of Current Vessel Offset Measurement / Verification:
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration: Tumble tested winter 2009/2010

TEST INFORMATION

Test Date(s) / DN(s): 2011 DN090

System Operator(s): According to survey watch schedule

Wind / Seas / Sky: 15 kts, seas 3 ft

Locality: Chesapeake Bay

Sub-Locality: Vicinity of CBBT and Pilot area north of Cape Henry, VA
Bottom Type: sandy

Approximate Average Water Depth: variable

DATA ACQUISITION INFORMATION

Line Number Heading Speed
400_0739 145° ~9kts SOG
401_0730 325° ~8Bkts SOG
402_1655 020° ~9.5kts SOG
402_1705 200° ~9.5kts SOG
402_1758 020° ~5kts SOG
403_1915 280° ~7kts SOG
403_1934 100° 11.5kts COG

Page 1 of 2






TEST RESULTS

Navigation Timing Error: 0.00 seconds

Pitch Timing Error: 0.00 seconds

Roll Timing Error: 0.00 seconds

Pitch Bias: +0.30

Roll Bias: +0.18

Heading Bias: -0.05

Resulting CARIS HIPS HVF File Name: TJ_S222 Reson7125_STBD.hvf

NARRATIVE

The 2011 HSRR patch test for the Thomas Jefferson's Reson 7125 took place in southern Chesapeake
Bay in the vicinity of Cheseapeake Channel and the pilot area north of Cape Henry, VA. Pitch and Nav
lines were acquried along a steep slope along the northern boundary of the pilot area. Roll lines were
acquried in a relatively deep and flat area in the northern part of the pilot area. Yaw lines were acquired
over a charted obstruction south and east of Chesapeake Channel, approximately 4nm northwest of the
CBBT. Seeimage beIow}.

. - . .
% = L e
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§$222- DN232 7125 Patch Test Results

Multibeam Echosounder Calibration
Field Unit: Thomas Jefferson §222
Date of Test: 20 AUG 2011
Calibrating Hydrographer(s). LT Davidson

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: 7125 400Khz 512 beams
System Location: STBD Sonar Strut

Sonar Serial Number:
Processing Unit Serial Number:

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: hull mounted
Date of Current Vessel Offset Measurement / Verification:
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration: Winter '09 - 10

TEST INFORMATION

Test Date(s) / DN(s): 232

System Operator(s):

Wind / Seas / Sky:

Locality: Block Island Sound
Sub-Locality: Vicinity of Southwest Ledge
Bottom Type: variable

Approximate Average Water Depth: 12m - 70m

DATA ACQUISITION INFORMATION

Line Number Heading Speed
101_1419 (Pitch) 275° 52 kis
101_1506 (Pitch and Nav Time)  095° 4.9 ks
101_1557 (Nav Time) 095° 9.5 kis
010_1804 (Roll) 340° 10.1 kis
010_1813 (Roll) 160° 8.9 kts
012_1846 (Yaw) 181° 9.6 kis
1 02;1 858 (Yaw) 181° 9.5 kis
Page 1 0f 2
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TEST RESULTS

Navigation Timing Error:  0.00

Pitch Timing Error: N/A

Roll Timing Error: N/A

Pitch Bias: -0.06

Roll Bias: +0.12

Heading Bias: -0.67

Resulting CARIS HIPS HVF File Name: TJ_S$222 RESON7125_STBD.hvf

NARRATIVE

Patch test for 5222 Reson 7125 ROV 400kHz in Block Island Sound in the vicinity of Southwest Ledge.

Nav and Pitch lines along a steep, bounded slope. Rolllines are in a deep, flat, featureless area. Yaw
lines were acquired in a flat rocky area with many isolated rocks in an otherwise flat sandy bottom.
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A.2.3. 3101- DNO0O59 7125 Patch Test Results

Multibeam Echosounder Calibration
Field Unit: Thomas Jefferson Launch 3101
Date of Test: 28 Feb 2011 and March 2 2011
Calibrating Hydrographer(s): SST Lewit

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: 7125 400Khz 512 beams
System Location:

Sonar Serial Number:
Processing Unit Serial Number:

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: pole-mount on port side of vessel
Date of Current Vessel Offset Measurement / Verification: Jan 2011 Antennas Only
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration:

TEST INFORMATION

Test Date(s) / DN(s): 059 and 61

Acquired by:ST Wood

Wind / Seas / Sky: Wind SW @ 25kts 2ft
Locality: Elizabeth River VA

Sub-Locality: Maersk terminal

Bottom Type: sandy

Approximate Average Water Depth: 8-20 meters

DATA ACQUISITION INFORMATION

Line Number Heading Speed
001-1808 South clutch ahead NAV
001-1812 South 9.5kts NAV
002_1419 West 7.0kts ROLL
002_1425 East 7.0Kis Rol
003_1511 South 70Kt Pitch
003_1521 North 7.0kts Pitch
004_1525 South 7.0 ks Yaw
005_1530 South 7.0Kts Yaw

Page 1 of 2
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TEST RESULTS

Navigation Timing Error: 0

Pitch Timing Error: N/A N/A

Roll Timing Error: N/A N/A

Pitch Bias: 1.28 (+1.567 entered into 2011 hvf)
Roll Bias: "-0.62 (-0.418 entered into 2011 hvf)"
Heading Bias: "-0.34 (+1.033 entered into 2011 hvf)"

Resulting CARIS HIPS HVF File Name: TJ_3101_Reson7125_400khz.hvf

NARRATIVE

Analysis of the 2011 HSRR did not indicate that biases were better resolved than the values from 2010.
Therefore, the 2010 values are retained for the beginning of the 2011 season.

Page 2 of 2




A.2.4. 3102- DNO56 7125 Patch Test Results

Multibeam Echosounder Calibration

Field Unit: Thomas Jefferson Launch 3102
Date of Test: 25 Feb 2011
Calibrating Hydrographer(s): SST Lewit (Final values - LT Davidson)

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: 7125 400Khz 512 beams
System Location:
Sonar Serial Number:

Processing Unit Serial Number:

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: pole-mount on port side of vessel
Date of Current Vessel Offset Measurement / Verification: Jan 2011 Antennas Only
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration:

TEST INFORMATION

Test Date(s) / DN(s): 056

System Operator(s): SST Lewit

Wind / Seas / Sky: Wind SW @ 25kts 2ft
Locality: Elizabeth River VA

Sub-Locality: Maersk terminal

Bottom Type: sandy

Approximate Average Water Depth: 8-20 meters

DATA ACQUISITION INFORMATION

Line Number Heading Speed
001-1743 South clutch ahead NAV
001-1748 South 9.5 kts NAV
002-1753 West 8.5kts ROLL
002-1755 East 8.5 kts Roll
003-1758 South 8.5kts Pitch
003-1800 North 8.5 kts Pitch
004-1804 South 8.5 kts Yaw
005-1808 South 8.5 kts Yaw

Page 1 of 2
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TEST RESULTS

Navigation Timing Error:  0.00

Pitch Timing Error: N/A

Roll Timing Error:  N/A

Pitch Bias: -0.10 (+1.80 entered into 2011 DAPR)

Roll Bias: -0.99 (-0.92 entered into 2011 DAPR)

Heading Bias: -1.04 (-0.897 entered into 2011 DAPR)

Resulting CARIS HIPS HVF File Name: TJ_3102_Reson7125_400khz.hvf

NARRATIVE

Analysis of the 2011 HSRR did not indicate that biases were better resolved than the values from 2010.
Therefore, the 2010 values are retained for the beginning of the 2011 season.

Page 2 of 2
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A.2.5.

3102- DN233 7125 Patch Test Results

Multibeam Echosounder Calibration

Field Unit: Thomas Jefferson Launch 3102
Date of Test: 21 AUG 2011
Calibrating Hydrographer(s): LT Davidson

MULTIBEAM SYSTEM INFORMATION

Multibeam Echosounder System: 7125 400Khz 512 beams
System Location:

Sonar Serial Number:
Processing Unit Serial Number:

Date of Most Recent EED / Factory Checkout:

VESSEL INFORMATION

Sonar Mounting Configuration: hull mounted with rotating deployment config
Date of Current Vessel Offset Measurement / Verification: Jan 2011 Antennas Only
Description of Positioning System: POS/MV version 4 w/ Precise Timing

Date of Most Recent Positioning System Calibration: Winter '09 -"10

TEST INFORMATION

Test Date(s) / DN{s): 233

System Operator(s). SST Lewit

Wind / Seas / Sky:

Locality: Block Island Sound
Sub-Locality: Vicinity of Southwest Ledge
Bottom Type: variable

Approximate Average Water Depth: 12m - 70m

DATA ACQUISITION INFORMATION

Line Number Heading Speed
101_1846 (Pitch) 275° ~6.5kts
101_1849 (Nav) (Pitch) 095° ~6.5kis
101_1852 275° ~10.5Kts
101_1855 (Nav) 095° ~10Kts
100_1815 (Roll) 160°T 7ids
100_1819 (Roll) 340° 8.5Kts

Page 1 of 2
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TEST RESULTS

Navigation Timing Error:  0.00

Pitch Timing Error: N/A

Roll Timing Error: N/A

Pitch Bias: +0.28

Roll Bias: -0.88

Heading Bias: -1.50

Resulting CARIS HIPS HVF File Name: TJ_3102_Reson7125_400khz.hvf

NARRATIVE

Patch test for 3102 Reson 7125SV 400kHz in Block Island Sound in the vicinity of Southwest Ledge.
Nav and Pitch lines along a steep, bounded slope. Roll lines are in a deep, flat, featureless area. Yaw
lines were acquired in a flat rocky area with many isolated rocks in an otherwise flat sandy bottom.

i SOU!hWBs? L edge
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A.3. Positioning & Attitude
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Applanix Pos/MV IMU 146 Certification

applanix

Certificate of Conformance

Applanix Corporation certifies that the material listed below has been tested in
accordance with approved test procedures and was found to meet or exceed published
“specifications.

1) Description: IMU LN200
Applanix Part Number: 10000770
IMU Serial Number: 402952 (Top Hat # 146)

Return Material Authorization #: 1.09-051

Customer: NOAA
Atlantic Branch at MOC

w Z | ; 2 February, 2010

Certified By: Date:
Bruce Francis
Customer Support Engineer
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Applanix Pos/MV IMU 352 Certification

applanix

Certificate of Conformance

Applanix Corporation certifies that the material listed below has been tested in
accordance with approved test procedures and was found to meet or exceed published
specifications.

1) Description: IMU LN200
Applanix Part Number: 10002416
IMU Serial Number: 410461 (Top Hat # 352)

Return Material Authorization #: 1.09-051

Customer: NOAA
Atlantic Branch at MOC

&% Z 2 February, 2010

Certified By: Date:
Bruce Francis
Customer Support Engineer
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Applanix Pos/MV IMU 356 Certification

applanix

Certificate of Conformance

Applanix Corporation certifies that the material listed below has been tested in
accordance with approved test procedures and was found to meet or exceed published
“specifications.

1) Description: IMU LN200
Applanix Part Number: 10002416
IMU Serial Number: 407301 (Top Hat # 356)

Return Material Authorization #: L.09-051

Customer: NOAA
Atlantic Branch at MOC

w Z 2 February, 2010

Certified By: Date:
Bruce Francis
Customer Support Engineer
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A.3.4.

Applanix Pos/MV GAMS Calibration S222

POS/MV Calibration Report

Field Unit: Thomas Jefferson

SYSTEM INFORMATION

Vessel:

MNOAA Ship Thomas Jefferson 5222

Date:

Personnel:

3/30/2011 Dr: 39

55T Lewit

PCS Serial #

IP Address:

2321
120.100.1.231

POS controller Version (Use Menu Help > About)

JPOS Version (Use Menu View > Statistics)
GPS Receivers

Primary Receiver

4.34.0

I 320 Verd

5GN 45226458117

Secondary Receiver

SGN 45268459133

CALIBRATION AREA

JLocation: Chesapeake Bay

Approximate Position:

DGPS Beacon Station:

Lat 37 17

4.81

Lon 76 7

5.39

Driver, WA,

Satellite Constellation
Primary GPS (Port Antenna)

HDOP: 0.949
VDOP: 1.031

Sattelites in Use: 11
10,7,13,23,19,31,3,6,16,30,21

|[PDOP 2.716

(UseView> GAMS Solution)

Frequency: 288 kHZ

UseView> GPS Data)

Primary GNSS

Sl e

i 10800
il B
B

16,30

N

e s

11 Satellites \ ; /

\E

h

JNote: Secondary GFS satellite constellation and number of satellites were exactly the same as the Primary GPS
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POS/MV CONFIGURATION

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
2.209 Two Antenna Separation (m) 0.052 X Component (m)
0.50 Heading Calibration Threshold 2.207 YComponent (m)
0 Heading Correction -0.076 Z Component (m)
Configuration Notes:
POS/MV CALIBRATION
Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)

Start time: 01:36 UTC

End time: 01:44 UTC
Heading accuracy achieved for calibration: 0.25

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
2.211 Two Antenna Separation (m) 0.032 X Component (m)
0.500 Heading Calibration Threshold 2.209 Y Component (m)
0 Heading Correction -0.081 Z Component (m)
GAMS Status Online? X
Save Settings? X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: §222_PosConfig_gams_033011.NVM




A.3.5.

Applanix POS/MV 3101 GAMS Calibration

POS/MV Calibration Report

Field Unit: Thomas Jefferson

SYSTEM INFORMATION

Vessel: NOAA Launch 3101
Date: 2282011 Dn: 59
Personnel: SST wood
PCS Serial # 2320
IP Address: 1.20.100.1.231
POS controller Yersion (Use Menu Help > About) 4.3.4.0
JPOS Yersion (Use Menu View > Statistics) MW 320 Werd
GPS Receivers
Primary Receiver SGN 4526A53083
Secondary Receiver SGN 4533A50362

CALIBRATION AREA

JMote:

JLocation: M orfolk, Wb D M S
Approximate Position: Lat 36 52 4
Lon 76 19 33
DGPS Beacon Station: Driver, Wi
Frequency: 288 kHZ
Satellite Constellation (Use View> GNSS Data)
Primary GPS (Port Antenna) - N
Primary GNSS
HDOP: 0.878
WVDOP: 1.355 N
._//’"'_ 10
Sattelites in Use: 9 ; 29 0
f §0 1.0
25 a4
_ _ wi &
|PDOP Not recorded (Use Views> GAMS Solution) &
-_— 2
\\
: 6
TR 3
9 Satellit S
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POS/MV CONFIGURATION

File Name:

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
1.291 Two Antenna Separation (m) 0 X Component (m)
0.50 Heading Calibration Threshold 0 Y Component (m)
0 Heading Correction 0 Z Component (m)
Configuration Notes:
POS/MV CALIBRATION
Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: 1348
End time: 1350
Heading accuracy achieved for calibration: 0.032
Calibration Results:
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
1.296 Two Antenna Separation (m) -0.005 X Component (m)
0.500 Heading Calibration Threshold 1.296 'Y Component (m)
0 Heading Correction -0.021 Z Component (m)
GAMS Status Online? X
Save Settings? X
Calibration Notes:
Save POS Settings on PC (Use File » Store POS Settings on PC)

PosConfig_3101_28Feb-2011.nvm
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A.3.6. Applanix POS/MV 3102 GAMS Calibration

POS/MV Calibration Report
Field Unit:
SYSTEM INFORMATION
\Vessel: NOAA Launch 3102
Date: 2125/2011 Dn: 56
Personnel: SST Lewit CB Pooser
PCS Serial # 2562
IP Address: 129.100.0.231
POS controller Version (Use Menu Help > About) 5102
|POS Version {Use Menu View > Statistics) WW320 Verd
GPS Receivers
Primary Receiver SGMN 4617 ABS061
Secondary Receiver SGMN AG24A70252
CALIBRATION AREA
JLocation: Morfolk, WA D M S
Approximate Position: Lat 36 52 15
Lon TG 19 A6
DGPS Beacon Station: Driver, VA
Frequency: 289 kHZ
Satellite Constellation {Use View> GNSS Data)
Primary GPS (Port Antenna) N
Primary GNSS
HDOP: 0533
WVDOP: 1171 M
————————————————— _‘E\\
Sattelites in Use: ] 0 \&
— 2.1 50 Q
70
| A 36 L
IPDOP 1.559 (Use Yiew> GAMS Solution) e 20 A
- ] s
S
IMote
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POS/MV CONFIGURATION

Settings
Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
User Entries, Pre-Calibration Baseline Vector
Two Antenna Separation (m) X Component (m)
Heading Calibration Threshold YComponent (m)
Heading Correction Z Component (m)

Configuration Notes: The original values were not recorded

POS/MV CALIBRATION

Calibration Procedure: (Refer to POS MV V3 Installation and Operation Guide, 4-25)
Start time: This was not recorded
End time: This was not recorded

Heading accuracy achieved for calibration: This was not recorded

Calibration Results:

Gams Parameter Setup (Use Settings > Installation > GAMS Intallation)
POS/MV Post-Calibration Values Baseline Vector
1.531 Two Antenna Separation (m) 0.009 X Component (m)
0.500 Heading Calibration Threshold 1.531 Y Component (m)
0 Heading Correction -0.025 Z Component (m)
GAMS Status Online? X
Save Settings? X

Calibration Notes:

Save POS Settings on PC (Use File > Store POS Settings on PC)
File Name: Posconfig_3102_25Feb2011.NVM
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A.4. Sound Speed
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A.4.1. SBE 19+ SN285

A4.1.1. Conductivity Calibration Report

s B SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street Bellevue, Washington 98005 USA
CRRRRBELLL) phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer: [|Atlantic Marine Center |
lJob Number: || 61820 | [Date of Report: || 11/11/2010 |
[Model Number || SBE19 ] [Serial Number: || 192472-0285 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received' calibration is not performed if the sensor is damaged or non-
functional, or by customer request,

An 'as received’ calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the 'as received’ calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The
coefficient 'slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: [11/11/2010 Drift since last cal: |  +0.00060 PSU/month*
Comments:
'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed v Not Performed
Date: |:] Drift since Last cal: PSU/month*
Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



A.4.1.2. Conductivity Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERTAL NUMBER: 0285 SBE19 CONDUCTIVITY CALIBRATION DATA
CALIBRATION DATE: 11-Nov-10 PSS 1978: (C(35,15,0) = 4.2914 Seimens/meter
GHIJ COEFFICIENTS ABCDM COEFFICIENTS

g = -4.07944976e+000 a = 1.29103349e-002

h = 4.86633541e-001 b = 4.70521285e-001

i = 1.21190759e-003 o = —-4.06331630e+000

J o= -2.29868736e-005 d = -9.32582862e-005

CPcor = -9.5700e-008 {(nominal} m= 2.3

CTcor = 3.2500e-006 {(nominal} CPcor = -9.5700e-008 {nominal)

BATHTEMP  BATHSAL BATHCOND INSTFREO  INST COND RESIDUAL

(ITS-90) (PSU) {Siemens/m) (kHz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2.885506 0.00000 0.00000
1.00040 34.6461 2.96280 8.25139 2.%96274 -0.0000¢
4.5000 34.6263 3.26856 8.61509 3.26802 0.00006
15.0000 34.5830Q 4.24601 9.68473 4.24604 0.00003
18.5000 34.5731 4.58957 10.03319 4.58957 -0.00000
24.0000 34.5619 5.14495 10.57184 5.14494 -0.00001
29.0000 34.5543 5.66422 11.05131 5.66414 -0.00008
32.5000 34.5479 6.0344¢ 11.38081 6.03452 0.00008

Conductivity = (g + hf” +if " + jf } /10(1 + 3t + &p) Siemens/meter
Conductivity = (af "t bf : + ¢ +dty/[10 (1 +ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; 8 = CTcor; € = CPcor;

Residual = (instrument conductivity - bath conductivity) using g, h, i, j coefficients

Date, Slope Correction

0.002 [@] 17-Dec-09 1.0002257
[A]11-Nov-10 1.0000000
0.001
E
25
= A | N
§ 0.000 ——1—3 Ak
5,
N
{
o \
|
0.001 \/.\—.\t/—o/‘/
-0.002 1 111 1 111 1 111 1 111 1 111 1 111 1 111
0 1 2 3 4 5 6 7

Conductivity (Siemens/m)



A.4.1.3. Pressure Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 0285 SBE19 PRESSURE CALIBRATION DATA
CALIBRATION DATE: 16-Nov-10 5000 psia S/N 133807 TCV: -121
QUADRATIC COEFFICIENTS: STRAIGHT LINE FIT:
P20 = 2.492113e+003 M = -6.503083e-001
PRl = -6.502899e-001 B = 2.491853e+003
PA2 = -4.326982e-008
PRESSURE INST COMPUTED ERROR LINEAR ERROR
PSIA OUTPUT(N) PSIA %FS PSIA %FS
14.56 3809.0 14.53 -0.00 14.83 0.00
1014.92 2272.0 1014.43  -0.01 1014.35  -0.01
2015.13 735.0 2014.13 -0.02 2013.88  -0.03
3015.06 -504.0 3014.92  -0.00 3014.70 -0.01
4015.08  -2342.0 4014.86  -0.00 4014.87  -0.00
5015.02  -3880.0 5014.59 -0.01 5015.05 0.00
4014.93  -2343.0 4015.51 0.01 4015.53 0.01
3014.9¢ -806.0 301e.22 0.03 301e6.00 0.02
2014.95 734 .0 2014.78 -0.00 2014.53 -0.01
1014.85 2271.0 1015.08 0.00 1015.00 0.00
14.66 3808.0 15.18 0.01 15.48 0.02
Straight Line Fit:
Pressure {psia) = M * N + B (N = binary output)
Quadratic Fit:

pressure (psia) = PAO + PA1 * N + PA2 * N’
Residual = (instrument pressure - true pressure) * 100 / Full Scale Range

Date, Avg Delta P %FS

0.50 [@] 16-Nov-10 -0.00

o
i
&

o.oo%.::_—_g;_dr/’:\ ——8— g
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A4.1.4. Temperature Calibration Report

S B SEA-BIRD ELECTRONICS, INC.

13431 NE 20th St. Bellevue, Washington 98005 USA
(RRRRRELLE) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Atlantic Marine Center |
lJob Number: || 61820 | [Date of Report: || 11/11/2010 |
[Model Number || SBE19 | |Serial Number: || 192472-0285 |

Temperature sensors are normally calibrated 'as received’, without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received’ calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: Drift since last cal: Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR’ Performed v! Not Performed
Date: |:| Drift since Last cal: |:I Degrees Celsius/year
Comments:
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A.4.1.5. Temperature Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Emall: seabird@seabird.com

SENSOR SERIAL NUMBER: 0285 SBE19 TEMPERATURE CALIBRATION DATA
CALIBRATION DATE: 11-Nov-10 ITS-90 TEMPERATURE SCALE
ITS-90 COEFFICIENTS [PTS-68 COEFFICIENTS
g = 4.12504156e-003 a = 3.64764210e-003
h = 5.75337354e-004 b = 5.70436400e-004
i = -8.04668896e-007 c = 6.88256027e-006
j = =3.07104747e-00¢6 d = -3.07098183e-006
f0 = 1000.0 fO0 = 2297.617
BATH TEMP INSTRUMENT FREO INST TEMP RESIDUAL
(ITS-90) {Hz) (ITS-90) (ITS-90)
1.00040 2297.617 0.9995 -0.00054
4.5000 2490.828 4.5010 0.00098
15.0000 3139.173 14.9993 -0.00072
18.5000 3379.607 18.49%96 -0.00037
24,0000 3783.392 24.0007 0.00067
29.0000 4178.956 29.0004 0.00043
32.5000 4472.598 32.4995 ~0.00046

Temperature ITS-90 = 1/{g + hlin(f /)] + i[an(fO/f)] +j[ln3(f0/f)]} -273.15 (°C)
Temperature IPTS-68 = 1/{a + bin(f /0] + clin (£ /)] + dLin’(£ /0]} - 273.15 (°C)
Following the recommendation of JPOTS: Tss is assumed to be 1.00024 * T90 (-2t0 35 °C)
Residual = instrument temperature - bath temperature

Date, Offset(mdeg C)

0.02 [@] 17-Dec-08 -0.52
[A]11-Nov-10 -0.00
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A.4.2. SBE 19+ SN 4486

A4.2.1. Conductivity Calibration Report

SB SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street Bellevue, Washington 98005 USA
(RRARRRELLL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer: |[Atlantic Marine Center |
[ob Number: [[ 61820 | [Date of Report: || 11/10/2010 |
[Model Number || SBE 19Plus | [Serial Number: || 19P33589-4486 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received’ calibration is not performed if the sensor is damaged or non-

Jfunctional, or by customer request.

An 'as received’ calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the 'as received' calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON, The
coefficient 'slope’ allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration

coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: |11/10/2010 Drift since last cal: -0.00040 PSU/month*
Comments:

'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed ¥ Not Performed
Date: |:I Drift since Last cal: PSU/month*

Comments:

*Measured at 3.0 S/fm

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in

post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.

34



A4.2.2.

Residual, (S/m)

Conductivity Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERTAL NUMBER: 4486
CALIBRATION DATE: 10-Nov-10

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

COEFFICIENTS:
g = -1.029462e+000 CPcor = -9.5700e-008
h = 1.435105e-001 CTcor = 3.2500e-006
i = -2.257815e-004
i = 3.785683e-005
BATHTEMP  BATH SALL. BATH COND INST FREQ  INST COND RESIDUAL
(ITS-90) (PSU) {Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2681.44 0.0000 0.00000
0.9999 34.7063 2.96745 5279.93 2.9675 0.00000
4.5000 34.6861 3.27365 5477077 3.2738 -0.00001
14.9999 34.6425 4.25253 6066.39 4.2525 -0.00000
18.5000 34.6326 4.59062 6259.88 4.5966 0.00001
24.0000 34.6213 5.15282 6560.29 5.1528 0.00001
29.0000 34.6139 5.67289 6828.89 5.6729 -0.00002
32.5000 34.6084 6.04382 7014.02 65.0438 0.00001

f = INST FREQ / 1000.0
Conductivity = (g + hf* +if° + jf )}/ (1 + 8t + ep) Siemens/meter

t = temperature[°C)]; p = pressure[decibars]; 8 = CTcor; € = CPcor;

Residual = instroment conductivity - bath conductivity

Date, Slope Correction

[@] 23-Dec-09 0.9998628
[CA] 10-Nov-10 1.0000000

0.002
0.001 ’/./i
/././’././
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0.000 & P re A
-0.001
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Conductivity (Siemens/m)
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Residual, (% FSR)

A.4.2.3. Pressure Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4486 SBE19plus PRESSURE CALIBRATION DATA

CALIBRATION DATE: 08-Nov-10 508 psia S/N 2799

COEFFICIENTS:

PAO = 3.191141e-002 PTCAQ0 = 5.246486e+005

PRl = 1.549863e-003 PTCAL = 2.809928e+000

PA2 = 6.518813e-012 BTCA2 = -9.180600e-002

PTEMPAO = -7.532420e+001 FTCBO = 2.468737e+001

PTEMPAL = 4.817482e+001 PFTCBl = -7.250000e-004

PTEMPA2 = -2.155322e-001 BTCB2 = 0.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST

PSIA  OUTPUT OUTPUT PRESSURE  %FSR ITSS0 OUTPUT OUTPUT

14.65 534090.0 2.0 14.64 -0.400 32.50 2.26 534165.16
104.90 592268.0 2.0 104.89 -0.00 29.00 2.19 534174.11
204.93 656703.0 2.0 204.90 -0.01 24.00 2.08 534182.30
304.93 721106.0 2.0 304.92 -0.00 18.50 1.97 534190.51
404.94 785475.0 2.0 404.93 -0.00 15.00 1.89 534194.09
504.94 849804.0 2.0 504.94 -0.00 4.50 1.67 534178.92
404.95 785494.0 2.0 404,96 0.00 1.00 1.60 534173.52
304.95 721144.0 2.0 304.98 0.01
204.95 656736.0 2.0 204. 96 0.00 TEMP (ITS90} SPAN (mV)
104.94 592302.0 2.0 104.95 0.00 -5.00 24.69
14.65 534094.0 2.0 14.65 0.00 35.00 24.66

y = thermistor output; t = PTEMPAQ + PTEMPAL *y + PTEMPA2 * y2
x = pressure output - PTCAO - PTCAL * t - PTCA2 * %

n=x * PTCBO/ (PTCBO + PTCB1 * t + PTCB2 * tl)

pressure (psia) =PAO + PAL *n + PA2 * n’

Date, Avg Delta P %FS

0.50 [®]08-Nov-10 -0.00
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A4.2.4. Temperature Calibration Report

SB SEA-BIRD ELECTRONICS, INC.

13431 NE 20th St. Bellevue, Washington 98005 USA
RRARRREELLL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer:  |[Atlantic Marine Center |
Job Number: || 61820 | [Date of Report: || 11/10/2010 |
[Model Number || SBE 19Plus | [Serial Number: || 19P33589-4486 |

Temperature sensors are normally calibrated 'as received', without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received’ calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received’ calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: Drift since last cal: Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' Performed v Not Performed
Date: :l Drift since Last cal: I:l Degrees Celsius/year
Comments:
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A4.2.5.

Temperature Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSCOR SERIAL NUMBER: 4486
CALIBRATION DATE: 10-Nov-10

ITS-90 COEFFICIENTS

al =
al =
a2 =

[T S

al =

BATH TEMP
(ITS-90)
0.9939
4.5000

14.99399
18.5000
24.0000
29.0000
32.5000

.285758e-003
.555140e-004
.098471e-007
.179498e-007

INSTRUMENT
OUTPUT(n)

604341.109
535771.484
366314.953
320997.094
259599.188
212957.047
184831.953

MV =(n- 524288) /1.6e+007
R = (MV * 2.900e+008 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[In(R)] + a2[ln2(R)] + a3[ln3(R)]} -273.15 (°C)

Residual = instroment temperature - bath temperature

SBE19nlus TEMPERATURE CALIBRATION DATA
ITS-90 TEMPERATURE SCALE

INST TEMP
(ITS-90)

0.
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RESIDUAL
(ITS-90)
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0001
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Date, Delta T (mdeg C)

[@] 23-Dec-09 -0.96
(A ] 10-Nov-10  0.00
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A.4.3. SBE 19+ SN 4487

A.4.3.1. Conductivity Calibration Report

s B SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street Bellevue, Washington 98005 USA
(ERRREALLL) Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Conductivity Calibration Report

|Customer: |[Atlantic Marine Center |
Job Number: |[ 61820 | [Date of Report: || 11/10/2010 |
[Model Number |[ SBE 19Plus | [Serial Number: || 19P33589-4487 |

Conductivity sensors are normally calibrated 'as received', without cleaning or adjustments, allowing a determination of
sensor drift. If the calibration identifies a problem or indicates cell cleaning is necessary, then a second calibration is
performed after work is completed. The 'as received’ calibration is not performed if the sensor is damaged or non-
Sfunctional, or by customer request.

An 'as received' calibration certificate is provided, listing the coefficients used to convert sensor frequency to
conductivity. Users must choose whether the 'as received' calibration or the previous calibration better represents the
sensor condition during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The
cocfficient 'slope' allows small corrections for drift between calibrations (consult the SEASOFT manual). Calibration
coefficients obtained after a repair or cleaning apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: |11/10/2010 Drift since last cal: -0.00020 | PSU/month*
Comments:
'CALIBRATION AFTER CLEANING & REPLATINIZING' Performed v| Not Performed
Date: |:| Drift since Last cal: PSU/month*
Comments:

*Measured at 3.0 S/m

Cell cleaning and electrode replatinizing tend to 'reset’ the conductivity sensor to its original condition. Lack of drift in
post-cleaning-calibration indicates geometric stability of the cell and electrical stability of the sensor circuit.



A.4.3.2.

Residual, (S/m)

Conductivity Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSCR SERTAL NUMBER: 4487
CALIBRATION DATE: 10-Nov-10

COEFFICIENTS:

g = -1.021473e+000
h = 1.394711e-001
i = -1.760513e-004
j = 3.330787e-005

SBE19plus CONDUCTIVITY CALIBRATION DATA
PSS 1978: C(35,15,0) = 4.2914 Siemens/meter

CPcor

-9.5700e-008

CTcor = 3.2500e-006

BATH TEMP  BATH SAL BATHCOND INSTFREOQO  INST COND RESIDUAL
(ITS-90) (PSU) (Siemens/m) (Hz) (Siemens/m) (Siemens/m)
22.0000 0.0000 0.00000 2708.53 0.0000 0.00000
0.9999 34.7063 2.96745 5347.73 2.9675 0.00000
4.5000 34.6861 3.27365 5548.45 3.273¢6 -0.00001
14.9999 34.6425 4.25253 6145.58 4.2525 0.00000
18.5000 34.632¢ 4.59662 6341.85 4.59%¢66 0.00000
24.0000 34.6213 5.15282 6646.56 5.1528 0.00000
29.0000 34.6139 5.67289 6919.01 5.6729 -0.00001
32.5000 34.6084 6.04382 7106.78 6.0438 0.00001
f=TNST FREQ / 1000.0
Conductivity = (g + hf*+if° +if ") / (1 + 8t + ep) Siemens/meter
t = temperature[°C)]; p = pressure[decibars]; & = CTcor; € = CPcor;
Residual = instrument conductivity - bath conductivity
Date, Slope Correction
0.002 [@] 23-Dec-09 0.9999133
[A]10-Nov-10 1.0000000
0.001
/.—0/"'4/
——
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A.4.3.3. Pressure Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 98005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4487 SBE19vlus PRESSURE CALIBRATION DATA

CALIBRATION DATE: 08-Nov-10 508 psia S/IN 2837

COEFFICIENTS:

PRO = 6.679933e-002 PTCAO0 = 5.244274e+005

PAl = 1.555865e-003 BTCALl = 4.143632e+000

PA2 = 6.564530e-012 FTCAZ = -1.000848e-001

PTEMPAOD = -7.455275e+001 PTCBO = 2.498675e+001

PTEMFAL = 4.916832e+001 FTCRBl = -5.000000e-005

PTEMPAZ = -3.918811e-001 FTCB2 = 0.000000e+000

PRESSURE SPAN CALIBRATION THERMAL CORRECTION

PRESSURE INST THERMISTOR COMPUTED ERROR TEMP THERMISTOR  INST
PSIA OUTPUT OUTPUT PRESSURE  %FSR ITSS0 OUTPUT OUTPUT
14.65 533835.0 2.0 14.64 -0.00 32.50 2.22 533927.31
104.90 591833.0 2.0 104.91 0.00 29.00 2.14 533933.29
204.93 656046.0 2.0 204.90 -0.01 24,00 2.04 533935.02
304.93 720235.0 2.0 304.91 -0.00 18.50 1.92 533936.32
404.94 784395.0 2.0 404.93 -0.00 15.00 1.85 533942.22
504.94 848510.0 2.0 504.94 -0.00 4.50 1.63 533913.75
404.95 784414.0 2.0 404. 96 0.00 1.00 1.56 533899.87
304.95 720270.0 2.0 304.97 0.00
204.95 656079.0 2.0 204,95 0.00 TEMP (ITS90} SPAN (V)
104.94 591859.0 2.0 104.95 0.00 -5.00 24.99
14.65 533842.0 2.0 14.65 0.00 35.00 24.98

y = thermistor output; t = PTEMPAO + PTEMPA1 * y + PTEMPA?2 * y2
x = pressure output - PTCAQ - PTCA1 * t - PTCA2 * t

n=x *PTCBO/(PTCBO + PTCB1 * t + PTCB2 # tz)

pressure (psia) = PAQ + PAL * n + PA2 1

Date, Avg Delta P %FS
0.50

(@] 08-Nov-10 -0.00
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A.4.3.4. Temperature Calibration Report

SB SEA-BIRD ELECTRONICS, INC.

13431 NE 20th St. Bellevue, Washington 98005 USA
RRRRRELLL Phone: (425) 643-9866 Fax: (425) 643-9954 www.seabird.com

Temperature Calibration Report

|Customer: |[Atlantic Marine Center |
|Job Number: || 61820 | [Date of Report: || 11/10/2010 |
[Model Number || SBE 19Plus | [Serial Number: ||  19P33589-4487 |

Temperature sensors are normally calibrated 'as received’, without adjustments, allowing a determination sensor drift. If
the calibration identifies a problem, then a second calibration is performed after work is completed. The 'as received’
calibration is not performed if the sensor is damaged or non-functional, or by customer request.

An 'as received’ calibration certificate is provided, listing coefficients to convert sensor frequency to temperature. Users
must choose whether the 'as received' calibration or the previous calibration better represents the sensor condition
during deployment. In SEASOFT enter the chosen coefficients using the program SEACON. The coefficient 'offset’
allows a small correction for drift between calibrations (consult the SEASOFT manual). Calibration coefficients
obtained after a repair apply only to subsequent data.

'AS RECEIVED CALIBRATION' v Performed Not Performed
Date: Drift since last cal: Degrees Celsius/year
Comments:

'CALIBRATION AFTER REPAIR' Performed V' Not Performed
Date: |:| Drift since Last cal: :l Degrees Celsius/year
Comments:
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A.4.3.5. Temperature Calibration Data

SEA-BIRD ELECTRONICS, INC.

13431 NE 20th Street, Bellevue, Washington, 28005-2010 USA
Phone: (425) 643 - 9866 Fax (425) 643 - 9954 Email: seabird@seabird.com

SENSOR SERIAL NUMBER: 4487 SBE19plus TEMPERATURE CALIBRATION DATA
CALIBRATION DATE: 10-Nov-10 ITS-90 TEMPERATURE SCALE

ITS-90 COEFFICIENTS
al = 1.222783e-003

al = 2.580636e-004
az2 = 3.403966e-007
a3 = 1.314272e-007
BATH TEMP INSTRUMENT INST TEMP RESIDUAL
(ITS-90) OUTPUT(n) (ITS-90) (ITS-90)
0.9999 713456.770 0.9999 0.0000
4.5000 638138.984 4.5000 -0.0000
14.9999 447165, 426 14.9399 0.0000
18.5000 394894.164 15.5000 -0.0000
24.0000 323256.656 24.0000 -0.0000
29.0000 268206.672 29.0000 0.0000
32.5000 234740.016 32.5000 -0.0000

MV =(n- 524288) / 1.6e+007
R = (MV * 2.900e+008 + 1.024e+008) / (2.048e+004 - MV * 2.0e+005)

Temperature ITS-90 = 1/{a0 + al[In{R)] + aZ[ln2(R)] + aS[ln3(R)]} -273.15(°C)
Residual = instrument temperature - bath temperature

Date, Delta T {mdeg C)
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A.4.4.

A4.4.1.

Customer:

Asset Serial Number:
Asset Product Type:
Calibration Type:
Calibration Range:
Calibration RMS Error:
Calibration ID:

MVP-100 SN 4988

Pressure Calibration Certificate

<AOML
AN ccrocnamnic

Certificate of Calibration

NOAA - Marine Operations Center Atlantic
004988 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke
Pressure

1000 dBar

.0353

004988 021407 0XE111 260111 130048

004988 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Installed On:

Coefficient A:  -1.569447E+3 Coefficient G: -7.050158E-8
Coefficient B:  -8.337370E-1 Coefficient H: -5.412054E-9
Coefficient C:  2.784933E-3 Coefficient I:  8.759462E-9
Coefficient D:  1.651412E-4 Coefficient J: -2.154370E-11
Coefficient E:  4.767409E-2 Coefficient K: -1.798432E-12
Coefficient F:  2.482477E-5 Coefficient L: 3.779060E-14

Coefficient M:

Calibration Date:
Certified By:

26/1/2011

-

j | A

i | - ,;!

/| M, l i
‘x““«( i ’VJ SR

|\

Robert Haydock
President, AML Oceanographic

AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA

T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com
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A4.4.2.

Sound Velocity Calibration Certificate

AML
“", SR S

Certificate of Calibration

Customer: NOAA - Marine Operations Center Atlantic

Asset Serial Number: 004988 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Asset Product Type: Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Calibration Type: Sound Velocity

Calibration Range: 1400 to 1550 m/s

Calibration RMS Error: .0182

Calibration ID: 004988 011712 139859 170111 221816

Installed On: 004988 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Coefficient A:  1.529664E+3 Coefficient G:  0.000000E+0

Coefficient B:  -1.120304E+2 Coefficient H: 0.000000E+0

Coefficient C:  8.985080E+0 CoefficientI:  0.000000E+0

Coefficient D:  -7.303128E-1 Coefficient J:  0.000000E+0

Coefficient E:  0.000000E+0 Coefficient K:  0.000000E+0

Coefficient F:  0.000000E+0 Coefficient L:  0.000000E+0
Coefficient M:

Calibration Date: 18/1/2011

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com
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A.4.5. MVP-100 SN 5340

A4.5.1.

Pressure Calibration Certificate

YAM L
“v" OCEANOGRAPHIC

Certificate of Calibration

Customer: NOAA - Marine Operations Center Atlantic

Asset Serial Number: 005340 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Asset Product Type: Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Calibration Type: Pressure

Calibration Range: 1000 dBar

Calibration RMS Error: 0255

Calibration ID: 005340 127028 0ZE092 260111 142138

Installed On: 005340 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke

Coefficient A:  -1.918104E+3 Coefficient G: -9.419392E-7

Coefficient B:  -1.399663E+0 Coefficient H: 1.044152¢-8

Coefficient C:  2.217375E-2 Coefficient I:  1.235858E-8

Coefficient D:  -1.520440E-4 CoefficientJ:  -1.508418E-10

Coefficient E:  5.847678E-2 Coefficient K: 8.793572E-12

Coefficient F:  4.658058E-5 Coefficient L:  -1.896560E-13
Coefficient M:

Calibration Date: 26/1/2011

Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described abave has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchamgeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA
T: +#1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com

46



Sound Velocity Calibration Certificate

AML
.‘v" » O?EANOGRAPHIC

Certificate of Calibration

Customer: NOAA - Marine Operations Center Atlantic

Asset Serial Number: 005340 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke
Asset Product Type: Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke
Calibration Type: Sound Velocity

Calibration Range: 1400 to 1550 m/s

Calibration RMS Error: .0169

Calibration ID: 005340 126551 127004 170111 221816

Installed On: 005340 Smart SV&P for Brooke MVP - PDC-A0200-OEM-Brooke
Coefficient A:  1.532143E+3 Coefficient G: 0.000000E+0
Coefficient B:  -1.071905E+2 Coefficient H: 0.000000E+0
Coefficient C:  7.531091E+0 Coefficient I:  0.000000E+0
Coefficient D:  -3.418192E-1 Coefficient J:  0.000000E+0
Coefficient E:  0.000000E+0 Coefficient K:  0.000000E+0
Coefficient F:  0.000000E+0 Coefficient L:  0.000000E+0

Coefficient M:

Calibration Date: 18/1/2011
Certified By:

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are
available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com
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A.4.6. MVP-100 SN 7591

A.4.6.1. Pressure Calibration Certificate

mAM L

OCEANOGRAPHIC

Xchanqe your old ideas

Certificate of Calibration

Customer: Rolls-Royce Canada Limited, Naval Marine

Asset Serial Number: 007591

Asset Product Type: Micro SV&P for Brooke MVP - PDC-A1300-OEM-Brooke

Calibration Type: Pressure

Calibration Range: 1000 dBar

Calibration RMS Error: .0482

Calibration ID: 007591 129146 OTE599 280411 100126

Installed On:

Coefficient A:  -2.576150E+3 Coefficient G: 8.071607E-10

Coefficient B:  1.820538E-1 Coefficient H: -5.916234E-15

Coefficient C:  -4.133096E-6 Coefficient I:  -1.762715E-5

Coefficient D:  2.932489E-11 Coefficient J:  1.123850E-9

Coefficient E:  5.711748E-1 Coefficient K: -2.388330E-14

Coefficient F:  -3.660197E-5 Coefficient L:  1.691618E-19
Coefficient M:

Calibration Date (dd/mm/yyyy): 28/4/2011

Certified By:

o foobs

Robert Haydock

President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L 5X6 CANADA
T: +1-250-656-0771 F: +1-250-655-3655 Email: service@AMLoceanographic.com



A.4.6.2. Sound Velocity Calibration Certificate

vl OCEANOGRAPHIC
Xchange your old ideas

Certificate of Calibration

Customer: Rolls-Royce Canada Limited, Naval Marine

Asset Serial Number: 007591

Asset Product Type: Micro SV&P for Brooke MVP - PDC-A1300-OEM-Brooke

Calibration Type: Sound Velocity

Calibration Range: 1400 to 1600 m/s

Calibration RMS Error: .0154

Calibration ID: 007591 131945 135084 260411 233702

Installed On:

Coefficient A:  7.186609E-4 Coefficient G:  0.000000E+0

Coefficient B:  -7.408975E-5 Coefficient H: 0.000000E+0

Coefficient C:  7.368149E-7 Coefficient I:  0-000000E+0

Coefficient D: -4.088703E-7 Coefficient J:  0.000000E+0

Coefficient E:  0.000000E+0 Coefficient K:  0.000000E+0

Coefficient F:  0.000000E+0 Coefficient L:  0-000000E+0
Coefficient M:

Calibration Date (dd/mm/yyyy): 28/4/2011

Certified By:

e ol

Robert Haydock
President, AML Oceanographic
AML Oceanographic certifies that the asset described above has been calibrated or recalibrated with equipment referenced to
traceable standards. Please note that XchangeTM sensor-heads may be installed on assets other than the one listed above; this
calibration certificate will still be valid when used on other such assets. If this instrument or sensor has been recalibrated,
please be sure to update your records. Please also ensure that you update the instrument’s coefficient values in any post-
processing software that you use, if necessary. Older generation instruments may require configuration files, which are

available for download at our Customer Centre at www.AMLoceanographic.com/support

AML Oceanographic
2071 Malaview Avenue, Sidney B.C. V8L5X6 CANADA
T:+1-250-656-0771 F:+1-250-655-3655 Email: service@AMLoceanographic.com



A4.7.

Reson SV-1 SN 2008044 Calibration Certificate

0295 m/s
0.0092 m/s

M RESON A/S, Fabriksvangen 13, DK-3550 Slangerup
\@ Fax: +45 4738 0066, Phone: +45 4738 0022
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A.4.7.1. Reson SV-1 SN 2008027 Calibration Certificate

RESON
=

CalibratioA R FnaNFrGioRMeStM Sion : _ Tncl i firsin

[

RESO N RESON A/S, Fabriksvangen 13, DK-3550 Slangerup

Fax: +45 4738 0066, Phone: +45 4738 0022
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A.5. Static and Dynamic Draft
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A5.1.

A.5.2.

A.5.3.

Dynamic Draft- $222 DN089

Draft (m) Speed (m/s)
0.00 0.5
0.01 1
0.02 1.5
0.03 2
0.05 2.5
0.08 3
0.11 35
0.15 4
0.19 4.5
0.25 5
0.31 55
0.39 6
0.39 10

Dynamic Draft- 3101 DN059

Draft (m) Speed (m/s)
0.052 2.294
0.084 3.497
0.036 4.380
-0.042 5.299
-0.042 10.289

Dynamic Draft- 3101 DN232

Draft (m) Speed (m/s)
0.00 0.5
0.01 1
0.02 1.5
0.03 2
0.05 2.5
0.06 3
0.08 3.5
0.09 4
0.09 4.5
0.08 5
0.07 55
0.04 6

0 10
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A.5.4. Dynamic Draft- 3101 ERDDM Documentation

Introduction

As a vessel increases speed through the water a high pressure area is generated at the bow and a low pressure
area is generated at the stern. This causes the vessel to rise at the bow and settle at the stern, a phenomenon
called settlement and squat, or dynamic draft. As speed increases, the bow will continue to rise and the stern
will continue to squat until the vessel exceeds the threshold called planing speed, at which point the vessel
ceases to push through the water and rises up on top of the water and more or less trims out onto a level plane.
It is important to note than many vessels have displacement hulls, which means that they cannot reach planing
speed, and are therefore continuously operating in their dynamic range of settlement and squat.

For hydrographic survey vessels, it is critical to accurately measure the amount of settlement and squat
(dynamic draft) in order to accurately account for the effects of settlement and squat in the bathymetry. Many
methods exist to attempt to measure the settlement and squat of a vessel. For the 2011 fieldseason, NOAA Ship
Thomas Jefferson utilized an Inertially-aided post-processed kinematic approach (IAPPK) to determine the
settlement and squat for the ship and two hydrographic survey launches (HSL). This method is called an
ellipsoid referenced dynamic draft measurement (ERDDM). The method utilized for the 2011 Hydrographic
Systems Readiness Review on HSL 3101 is described below.

Method

On March 25, 2011 (DNO084), HSL 3101 conducted an Ellipsoid Reference Dynamic Draft Measurement
(\ERDD!\{I)Imi§sion in the Elizabeth River, in the vicinity of Lambert Bend to Pinner Point (See figure 1).
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Figure 1 — Subset of NOAA Chart 12253.
mission occurred.

The survey line indicated in Figure 1 was ran a total of 3 times beginning with a 2 minute dead-in-the-water
(DIW) period to establish the zero point for the ERDDM procedure. After the 2 minute DIW, HSL 3101 began
transiting the at low-idle clutch ahead. This speed was maintained for approximately 1 minutes, and then the
speed was increased to regular-idle clutch ahead for 1 minute. Next, the engine RPMs were increased by 200
and maintained for 1 minute. This step was repeated until the engine was at maximum speed. At the end of the
top speed run, the vessel stopped and began another 2 minute DIW period to conclude the first run. The steps
mentioned above were repeated until three complete runs were achieved. Figure 2 illustrates the speeds
achieved during the mission.

— B\h !

e red line indicates the approximate area where the ERDDM
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Figure 2 — Speed vs Time graph illustrating all 3 runs acquired during the ERDDM mission. The spike farthest
to the right is the transit back to the ship.

During the steps mentioned above, IAPPK data was logged using the Applanix POS/MV POSPAC file format.

The POSPac file logged for the day was processed using Applanix POSMMS 5.4 GNSS SmartBase Processing.

Nearby Continuously Operating Reference Stations (CORS) were used as control stations for the mission, see
figure 3. These stations are used to derive very accurate and precise measurements of errors associated with
ephemeris and clock data from the global navigation satellite system (GNSS), making it possible to derive
positions and altitudes to within a few centimeters of accuracy.
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Figure 3 — CORS used during the mission to provide a triangulated network for processing IAPPK data.
- X

Here are the resultz from SmartBase Cuality Check. The flazhing icon below the results table suggests the nest action.

SmartBase Quality Check Results Summary
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Figure 4 — Quality Check of CORS data during Applanix POSMMS 5.4 SmartBase processing of IAPPK data.
All stations passed the Quality Check and LOYZ was selected by the software as the Control Station for the
mission.

» |

| Status

| Termination Status ~ Normal

' Position Accuracy:

| |
| |

1 .0m .0 0.1 1.0 10 100m

Figure 5 — Termination Status and Positional Accuracy of the processed SBET indicating a positional accuracy
of approximately 1cm.

Forward and Backward processing terminated normally, creating a Smoothed Best Estimate Trajectory (SBET)
file with reported positional accuracy of approximately 1cm in the horizontal and approximately 3cm in the
vertical. PDOP was less than 3 for the duration of the mission. There were 7 or more SV’s in the solution for
the duration of the mission. The SBET generated for this mission was free of any anomalies or errors that
would degrade the results of the ERDDM.

The SBET file was processed keeping all the coordinates in ITRFOO until the Export step. In Export, a Custom
Smoothed BET was created which transformed the positions into UTM Zone 18N with NAD83 as the Datum.
See figures 6 and 7.

Project Settings

|23 General Information Output Fomat Reference ta Output Output wrt. Reference
|23 Coordinate System Lewer & Mounting Angles
(23 Units s | 0.000 m 5 0.000 deg
; Custorn Smoothed BET — + | B,
(0 View & Custom Smonihe v [0000m ¢ [0.000deq
23 Satelite Selection
23 GNSSdrertial Processar Z /0000 m z 0.000 deg
(== | Export Output B ate
p

23 Camera
(23 LiDaR Al Records -
3 54R

Height Options

BiEs [] Use Realtime Solution

(=) Ellipzoid

() Orthometric

[ wised

Timing

Start Entire time interval

End [] Seconds of start week

| NADEZ Universal Transverse Mercator LITH North 18 (78 to 72 NONE

Figure 6 — Settings for SBET export to a Custom Smoothed Best Estimate Trajectory during which, the mapping
frame was transformed from ITRFOO with WGS84 datum to UTM zone 18N with NAD 83 datum (NOAA
hydrographic data is delivered in UTM projection with NAD83 as the datum).
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Figure 7 — Mapping Frame Parameters

Once all export parameters were set, the message in figure 8 (below) was displayed to notify the use that
transformation occurred from WGS84 to NADS83, but no orientation was performed. This is not relevant for the
purposes of the ERDDM mission. “Yes” was selected and the export was completed.

Orientation Not Transformed

I Yex l [ Mo ]

Figure 8 — Orientation Not Transformed warning is not an issue for ERDDM — “Yes” chosen

Pydro is an in-house software application used primarily for survey feature management and report generation.
However, Pydro is also used to execute many customized macros designed to perform specific tasks as
necessitated by the NOAA survey mission. One particular macro was designed to read an SBET and derive a
dynamic draft table for the vessel used to acquired the POSPac data. The macro is:
ProcSBETDynamicDraft.py

and ProcSBETDynamicDraft.py macro is found in:

C:\Program Files\Pydro\Lib\site-packages\HSTP\Pydro\Macros\ProcSBETDynamicDraft.py

The script can be called directly from the location listed above, or by opening the Pydro application and
chooseing: Misc/Run Macro

The macro prompts the user for the ERDDM POSProc SBET file in either the binary “.out” or ASCII “.txt”
format. For this mission, the Customized Smoothed BET that was exported into UTM 18N, NAD83 was
selected in binary format - see Figure 9.
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Choose ERDDM POSProc SBET file--binary (.out) or ASCII (. txt)

Lok jr: | | E=part V| (&) ¥ £ -
by |E] expork_Mission 1,auk
ky Fecent
Dacuments
=
[
Dezktop

9

by Documents

o

by Computer

File name: |e:-cpu:urt_|'v1issiu:un 1.out b | [ Open l

MyMetwork  Filesoftpe: | out:" tat fles [%.out." tw) v | cencel |

Figure 9 — Binary format for the Customized Smoothed BET created during the previous steps was selected for
use by the ERDDM macro.

Once the SBET file has been selected, the macro prompts the user for the data in YYYY-DOY format — Figure
10.

Date D_(|

Enter year-doy of ERDDM data (-0

| 2011-084 |

[ Ok ] [ Cancel ]

Figure 10 — Date format for the ERDDM macro

Once the date has been entered in the proper format, the macro prompts the user to select the order of
polynomial best fit line to be used. Experience has shown that the 3™ order polynomial more accurately
represents the actually dynamic draft of the vessel. 4™ order polynomial lines tend to indicate a lift at very slow
speeds with a squat at the very high speeds. These lifts and squats are not indicative of the actual behavior of
the vessel at these speeds, but are controlled by the behavior of the 4™ order polynomial equations. 3" order
polynomial equations do not exhibit the same behavior at the extreme high and low speeds, and are therefore
considered to be more accurate for the purposes of ERDDM. For this mission, the 3™ order was used. See
figure 11.
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Polynomial Fit @

Desired polynomial-fit order?

3rd Crder
4th Order

[ ] 4 ] [ Cancel ]

Figure 11 — 3™ Order Polynomial best fit line was selected for this ERDDM mission.

Next, the macro prompts the user to specify a time range to use. The SBET may include an entire day’s worth
of data, but only the portion during the ERDDM acquisition is necessary. The entire SBET can be used, and the
macro will utilize the speed and altitude data to determine the ERDDM, however, a longer time range increases
the likelihood of a tidal anomaly to skew the data. For the purposes of this mission, a unique POSPac file was
logged just prior to the start of ERDDM acquisition, and was ended shortly after the acquisition was completed.
Therefore, the entire time range of the Customized Smoothed BET was used for this particular mission (Figure
12). By limiting the mission to approximately 40 minutes, the effect of tide was virtually eliminated from the
process. Water levels were not loaded as indicated by the error message (Figure 13). The effect of tides during
this mission was negligible and therefore tides were not applied. Additionally, TCARI tides were the only
option available for this area. When attempts were made to apply TCARI tides to the data, it crashed the
ERDDM script.

Figure 12 — Time range for the ERDDM mission.

L] E Mo water levels lnaded,
L

Figure 13 — Error message seen if water levels are not loaded prior to executing the ERDDM macro.

Pydro creates a series of graphs that document the output of the ERDDM macro. The first graph shows
ellipsoid height and the associated uncertainties vs time as recorded in the POSPac data (figure 14). The second
graph shows ellipsoid height vs speed and the residuals from the measurements to 2 standard deviations (figure
15). The third graph (figure 16) is the speed vs delta draft table with the 3" order polynomial best fit line,
which will be used in the CARIS HIPS and SIPS, HIPS vessel file (HVF).
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Figure 14 — Ellipsoid Height vs Time and the associated uncertainty

(= (=X

+ + measurements
— best-fit poly

+ + Residual

— 2STD

@00+« BE

Figure 15 — Ellipsoid Height vs Speed and the residuals to 2 standard deviations
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. Figure 3 EEX

-0.00249%X" +0.0178+.X* -0.00972#X

Speed [m/s] Delta Draft [m]

0.00 0.00
0.50 -0.00
1.00 0.01
150 0.02
2.00 0.03
2.50 0.05
3.00 0.06
3.50 0.08
4.00 0.09
4.50 0.09
5.00 0.08

5.50 0.07

6.00 0.04
6.50 0.00
7.00 -0.05
7.50 0.12

0.05 /
0.00

—0.10

Delta Draft [m, (+)down]

,.
Speed (m/s]

i ++ 8@

Figure 16 — Speed vs Delta Draft to be entered into the CARIS HIPS and SIPS, HIPS HVF. *Note — the values
in the graph are positive down values.

Results

The values derived from the ERDDM procedure for HSL 3101 match closely to the best estimates available by
any other method in the past. The statistical robustness of the ERDDM approach and the fact that all
subjectivity is removed from the process makes this approach more desirable than the reference surface
approach or the optical level approach.

The values listed in Figure 16 are used for the Draft section of the HVF for HSL 3101 beginning on DN232 for
the 2011 fieldseason. These values were not applied to the beginning because surveys were already processed
prior to successful ERDDM were determined.
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A.5.5.

Dynamic Draft- 3102 DN 056

Draft (m) Speed (m/s)
0.018 2.200
0.093 3.473
0.087 4.314
0.024 5.386
0.024 10.289
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